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1.0

Introduction to LCSS

The Lamprey Control Selection System (LCSS) is a software application that has
been developed to assist in long- and short-term management of sea lamprey
populations in the Great Lakes.

This manual provides an overview of the concepts that form the basis of the system.
This section outlines the hardware and software requirements you will need to run
LCSS, and provides installation instructions. Section 2 summarizes important LCSS
concepts. Section 3 outlines the various functions that you will encounter when using
LCSS. Section 4 describes the user interface and contains procedures and examples
of how to use the system. Section 5 outlines the user interface for ISIS, the IMSL
Stream Inspection System. Section 6 contains four appendices: Appendix A
describes the model that forms the foundation of LCSS; Appendix B provides an
overview of the database structure; Appendix C describes database-based graphing;
and Appendix D is a cross-referenced compilation of all the quick tips that appear in
Sections 4 and 5. Finally, Section 7 contains a comprehensive subject index to
enable users to quickly located the information they need about the LCSS user
interface.

Hardware & Software Requirements

LCSS requires an IBM-compatible computer capable of running Microsoft®
WINDOWS™ 95 We recommend that you run LCSS on no less than a Pentium
computer with 16MB of RAM and approximately 40 MB free hard drive space.

The system requires Microsoft Access (version 2.0) to support the database and
interrogative routines.

LCSS is an application that was developed using Visual Basic (version 5.0 SP3).

Installation Instructions

Diskettes:
1. Start Microsoft Windows 95.
2. Place the installation disk in drive A or B.
3. From the Start Menu, select Run.
4. Type A\SETUP.EXE (or B:\SETUP.EXE if you insert the disk into drive B).

Integrated Management of Sea Lamprey Decision Support Tools Introduction to LCSS e 1-1
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From CD:

1. Start Microsoft Windows 95.

2. Place the installation CD in the CD-ROM drive.
3. From the Start Menu, select Run.
4

Type D:\DISKI\SETUP.EXE (where D: identifies the CD-ROM drive on
your computer).
The installation program will automatically generate a group window containing a
program icons and a help file icon. Whenever you wish to run LCSS, double-click on
the program icon.

1-2 « Introduction to LCSS Integrated Management of Sea Lamprey Decision Support Tools
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2.0 General Concepts

This section describes the general concepts needed for a full understanding of the
Integrated Management of Sea Lamprey (IMSL) Decision Support Tools. It is
phrased from the point of the Lamprey Control Selection System (LCSS), the main
element of the IMSL suite and in most respects the superset of the functionality of the
suite. ISIS, the other main component, shares the model and most of the internal
structure with LCSS.

LCSS is a software tool designed to support the interactive design of the sea lamprey
control program in the Great Lakes. The tasks performed by LCSS include:

. assistance in the development of specific annual/tactical control program plans,

. strategic cost/benefit (economic injury level) analysis of alternative levels of
lamprey control,

. exploratory analysis of the effects and benefits of the development of new
barriers to lamprey migration, and

. exploratory analysis of the effects and benefits of emerging control techniques
such as sterile male release.

LCSS can help to integrate control program planning and research by providing a
common tool for program simulation and analysis that is accessible to both control
agents and research staff. As such, the system combines several practical concepts
developed by the lamprey control agents in tactical program planning with concepts
of population dynamics and modelling common in research circles. This section
provides an overview of some important spatial dynamics concepts that form the
foundation of the LCSS model. Further information about the model is in the
Appendix A.

System Overview

LCSS applies control options (including lampricide treatment, barriers, traps and
sterile male release) to modelled populations of larval and spawning phase sea
lamprey. The system operates on an inventory of streams that have produced lamprey
that have contributed to lake populations. Figure 2.1 presents the steps in the
simulation of spawning migration, recruitment, transformation, treatment ranking,
selection, and scheduling. The system considers lake and basin populations of
parasitic phase sea lamprey and the streams and portions of streams that produce
them.

Integrated Management of Sea Lamprey Decision Support Tools General Concepts ¢ 2-1
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Basins

LAMPREY BASINS

REPORTING BASINS

The spatial structure of lakes represented in the LCSS combines the basic units in
which populations of lamprey live, Lamprey Basins, and the spatial units in which
people think about and plan control actions, Reporting Basins.

A Lamprey Basin is defined as the area of a lake (or lakes) in which a single parasitic
phase population of lamprey resides. In LCSS, a lamprey basin is defined by: I) the
set of streams to which spawning phase lamprey migrate; and ii) the set of streams
from which transformers migrate. The default set of lamprey basins (basin definition
1) defines each of the five Great Lakes as a basin containing a single parasitic phase
population. The LCSS has the capability to define alternative sets of lamprey basins
or sub-basins within a lake.

The mechanism used to assign the pattern of spawner and transformer movement
allows LCSS users to specify migrations from a single stream to multiple basins (lake
areas) and from multiple basins to a single stream. For example, streams located near
the junction of Lakes Superior, Michigan and Huron can contribute transformers to
each of these three lamprey basins and receive spawners from each basin.

A Reporting Basin is a collection of streams or lamprey basins for which an LCSS
user wishes to summarize data.

At the level of single lake, a reporting basin and a lamprey basin define the same
area. However, within a large lake such as Lake Superior, the exact number and
extent of individual lamprey populations (or lamprey basins) is unknown. In
addition, various management agencies have defined management areas of the lakes
based on other criteria such as fishery quota management areas. The mechanisms for
defining lamprey and reporting basins within the LCSS are designed to provide a
high degree of flexibility in both simulating lamprey dynamics and reporting the
results of alternative analyses.

Note: This function has not yet been implemented.

Reaches and Chemical Options

When planning lamprey control, chemical treatments are applied in any year over the
actual extent of a stream where lamprey are abundant. The specific locations vary
from year to year within a stream and consequently no single set of predefined
treatment locations is in use. However, some general procedures have emerged from
the program. For example, in complex streams such as the Nemadji River (illustrated
below), treatments have been applied to major tributaries or portions of the stream.
In some years, only the Black River or the South Fork and Net River have been
treated, while in other years the entire river has been treated.

Integrated Management of Sea Lamprey Decision Support Tools General Concepts e 2-3
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REACH

To facilitate the simulation of lamprey populations within streams treated by the
LCSS, each stream that is potentially subject to lamprey control treatments has been
defined as consisting of a set of one or more reaches. Each reach corresponds to a
major portion of the stream that has received one or more treatments either
individually or as part of a larger treatment.

Reaches are the physical portions of the stream used by larval lamprey. The sum of
reach areas must total the area of the entire stream. The orientation of reaches (i.e.
upstream or downstream of each other) is maintained to account for downstream
movement of ammocetes and the effect of traps on upstream migrating spawners.

In the example below, the Nemadji River system has been designated as having three
reaches:

« the Black River;
+ the South Fork, including the Net River; and

« the main stem of the river into which the other two reaches drain.

S10712 \ L
Nemadji River

ake Superior

/

Morth Fork Nemadii Rf

"

/
; 4\ Black River
\—— Falls

s

#  South Fork Nemadji R.

‘_{ /\/(N;t River

CHEMICAL TREATMENT OPTIONS

Within the LCSS database, chemical treatment options have been defined for each
reach, and for each set of reaches which historically have been treated together.

In the example of the Nemadji system, chemical treatment options have been defined
for:

» the Black River;
+ the South Fork including the Net River; and for
+ the entire system.

No chemical treatment options have been defined for the main stem alone, since this
portion of the river is only treated in conjunction with one of the other two reaches.
The simulation model within the LCSS keeps track of individual lamprey populations
within each of the three reaches. When needed, the user can select a chemical
treatment option which affects the desired reaches.
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Barriers, Stream Configuration & Stream Barrier Activity

The concept of Stream Configuration provides a way to represent the change in in-
stream lamprey populations when a new barrier to lamprey movement is created. If
you are using the LCSS simply to schedule treatments for existing streams, with or
without barriers, you should not need to worry about stream configurations and
stream barrier activity. If you will be using the LCSS to explore the potential for new
barrier sites, you will need to understand these concepts.

In addition to individual reaches within a stream, the LCSS keeps track of alternative
stream configurations for each stream. An individual Stream Configuration is simply
a list of reaches which together define all areas of the stream.

At least one stream configuration is defined for every stream in the LCSS database.
For the vast majority of streams, the stream configuration is composed of only one
reach which defines the "entire stream". For more complex streams, the stream
configuration is simply a list of the various reaches that together describe the portions
of the stream to which various chemical treatment options may be applied.

For any stream on which a barrier may be created, a stream configuration set has to
be defined. If multiple barrier locations are to be explored, additional stream
configurations may be defined as needed.

Using the example of the Nemadji River, the basic stream configuration for the river
includes the Black River, the South Fork, and the main stem. If a barrier were to be
placed to prevent lamprey access to a part of the system, a second stream
configuration might be required, depending on the placement of the barrier. If the
barrier were placed at the confluence of either the Black River or South Fork with the
main stem, a new stream configuration would not need to be defined even though
access to one of the reaches had been barred. Although access to a part of the river
system had changed, the overall structure of the river system remains the same.

If, however, the barrier was located along the main stem of the system part way
between the two major tributaries a second stream configuration would be defined for
the system. Two new reaches would be described: one for the portion of the main
stem of the river below the barrier and another for the portion of the main stem above
the barrier. When using the new stream configuration definition for the stream, the
LCSS simulation model will separately track the development of lamprey
populations in these two areas. Additionally, new chemical options will need to be
defined for any treatments scheduled following barrier construction. This may be
done by modifying the chemical treatment options originally provided in the LCSS
database. LCSS will only simulate one stream configuration for any single run. To
simulate a presence or absence of barriers, we need to apply the concept of Stream
Barrier Activity.

Stream barrier activities specify different in-stream spawner allocations. Each stream
must have at least one stream barrier activity.

For streams that do have barriers, multiple stream barrier activities may be defined to
specify the spawner allocation under different barrier operating conditions. At Jeast
two stream barrier activities should be defined for each barrier stream, one
representing the spawner allocations to each stream reach in the "no barrier" (pre-
barrier) condition and a second representing the spawner allocations when the barrier
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is operational. Additional stream barrier activities may be defined if needed to
describe other situations (e.g., partial barrier failure, multiple barriers, etc.).

Treatment Windows

LCSS also takes into account temporal structure within the treatment season. While
the underlying model functions on an annual time-step, the model can simulate
effects of treating streams at different times in the season.

The flow characteristics of streams, seasonal patterns in stream biota, and the
logistics of applying chemical lampricide treatments are such that for many streams,
treatments are more effective at certain times of the year. For example, it may be
desirable to avoid times when environmental damage to non-target species could
occur, to avoid conflicts with recreational users, or to avoid periods of high water
flow.

Such differences are accounted for within the LCSS by designating a specific
treatment window to each chemical option. The date range for the treatment window
is a specific attribute of each chemical option and the corresponding window is
designated as being a preferred (P), acceptable (A), or not acceptable (N). The
effectiveness of a treatment on different age classes of ammocetes can be specified
for these windows. The amount of chemical required and the costs associated with
each window can also be defined. Whenever possible, users should avoid scheduling
treatments within negative treatment windows.
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3.0 Overview of LCSS Functions

This section provides a brief overview of the major functions of LCSS and describes
the general process that should be followed when using the system.

LCSS is made up of three major components:

1. The LCSS program. This provides an interactive interface for inputting
the data that is required to define a proposed treatment schedule. Using
its built-in simulation model of lamprey population dynamics, the system
estimates the effect of the schedule on lamprey populations;

2. A set of standard databases. These contain the details of the stream
inventory, standard chemical treatment options for each stream reach,
definitions of the standard budget and crew resources available for
carrying out the treatment program. The databases also contain the
output variables from the simulation model; and

3. A relational database management system. This provides data
management functions to LCSS, and allows users to access database
review and reporting functions.

Major LCSS Functions

LCSS can be used to:

rank streams on the basis of the potential effect of treatments on stream
transformer production;

interactively modify control schedule treatments for developing short-term
control program (1 - 5 year) plans;

simulate the effects of barriers, traps and sterile male release on lamprey
populations, either separately or in concert with chemical treatments;

run long-term (e.g. 50 year) scenarios of alternative lamprey control programs
that select chemical treatment options based on user-specified stream selection
criteria and logistical constraints imposed by resource availability (chemicals,
people, budgetary);

manage the retention of control program scenarios for subsequent input to
Economic Injury Level (EIL) analyses, graphical inspection of relative
performance, and/or numerical analysis;
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+ generate standard reports of control program plans, review system generated
indicators of lamprey population status;

« explore the behaviour of the simulation models used by LCSS to assess the
implications of alternative assumptions about lamprey population dynamics and
treatment effects; and,

+ manage scenarios and keep track of planning activities undertaken with the
system.

The ability to explore the effects of alternative selection criteria and the implications
of modifications to short-term control plans will assist in the long-term identification
of preferred control plans that are consistent with maintaining lamprey populations at
EIL abundance. :

LCSS Scenarios

A scenario refers to the data needed to specify the conditions that will be simulated
by a single simulation analysis made with LCSS. A scenario includes the following
types of data:

« the starting conditions of lamprey populations (for all basins, streams, and
reaches to be simulated);

» the available budget and treatment resources (e.g. crews); and
detailed descriptions of the control treatments that are to be simulated by LCSS.

LCSS facilitates the process of defining a scenario by allowing the user to modify
standard default options. Users can also maintain and carry forward variable-length
scenarios of sea lamprey control programs for the Great Lakes basin. Results of
scenarios can be evaluated against recent assessment data and parameter adjustments
can then be made to improve the accuracy of these predictions.

LCSS simulates the following control methods for developing control plans or
scenarios:

TFM
TFM bars
Bayer - wettable powder

Traps (normally but not necessarily limited to assessment activities)

1

2

3

4. Bayer - granular
5

6. Barriers - with or without traps
7

Sterile Male Release Technique (SMRT).

Alternative control techniques such as chemical treatments, traps, barriers and SMRT
can be designated either individually or in combination. The databases contain
default chemical treatments for any stream or part thereof. These chemical treatments
can be modified to reflect the details of actual treatments as applied to meet the
specific environmental conditions encountered in the field.
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DEFAULT SCENARIO

When a new scenario is created, the starting data are provided by the default scenario
databases. The default scenario includes the starting conditions (i.e. 1957) for
lamprey in all basins, streams and reaches to be simulated; the available budget and
treatment resources;, and detailed descriptions of the control treatments to be
simulated by LCSS. The 4 most current years population are included. The default
scenario can be used to generate a complete history (use the Long-term run function
and select scheduled treatments) or to do future simulations starting with the current
year.

Modifying Scenarios

BARRIERS

If the scenario is to simulate conditions which are not reflected in the system-
standard input database, users must describe the new scenario before running the
model. The following must be taken into account before developing a schedule for
chemical treatments:

«  any known, anticipated or hypothesized changes in barrier status (operational or
not) including the planned implementation schedule for new barriers (within the
calculation horizon);

« any modifications, known or anticipated, to the placement of traps in streams and
operation of traps associated with barriers;

- any known, anticipated or hypothesized changes to the plans for SMRT during
the time frame of the scenario; and

« the anticipated control program budget and resources available for conducting the
chemical control program.

Users can describe the specific details of the new scenario using the Scenario
Description option under the Edit Menu.

Barrier creation and SMRT are a minor part of the current sea lamprey control
program in the Great Lakes basin. Unlike lampricide control, ranking streams for the
application of these methods is done outside of the current version of LCSS.
However, LCSS can predict the state of larval lamprey populations in a given stream
and the effect of barriers or SMRT applications. In this way, future scenarios of
barrier construction and SMRT can be evaluated in terms of their effects on the
ongoing chemical control program.

Barrier simulations essentially prevent sea lamprey from accessing a part or all of the
stream, thus reducing the effective lamprey habitat and lowering the stream's lamprey
productivity and chemical treatment priority (rank). Since some barriers may
occasionally be breached, LCSS has the capability of simulating upstream
populations as necessary.

Specifying the barrier placement and activity scenario requires the user to identify
which streams/reaches contain barriers and the proportion of habitat accessible to
lamprey when the barrier is "operational”. In addition, the user may specify temporal
changes in barrier activity for each year within the time-frame of the scenario.
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STERILE MALE RELEASE TECHNIQUE

LCSS's simulation of SMRT acts to decrease the spawning success in the stream,
which may lower the stream's priority (rank) for chemical treatment. For each stream
to be treated with SMRT, either the actual number of sterile males (to be/actually)
released or the release rate (number released relative to natural males) must be
specified. Streams that have been designated for SMRT may also be scheduled for
chemical treatment.

BUDGETS AND RESOURCES

One of the first steps in using LCSS is to enter the available resources, the resource
costs, and budgets for the current year and the years within the calculation horizon.
Available resources can be presented for the overall program or its subset.

Using the resource requirements for individual stream treatments, the total resource
requirements can be estimated for predicted levels of lamprey reduction.

STREAM RANKING

Before scheduling streams for treatment, users must specify which criteria should be
used by LCSS to estimate the relative importance of applying treatments to each
stream. The criteria available for ranking streams for applying chemical treatment in
any year are:

1. maximum effect on lamprey: the predicted number of future transformers
killed by the lampricide treatment (large number killed = high rank).

2. efficiency (benefit/cost) of lamprey reduction: the number of future
transformers killed per unit cost (large benefit/cost = high rank).

3. reduction in economic "damage" to the fish community: (value of lake
trout * estimated lake trout mortality attributable to lamprey predation
attributable to the stream): takes into account the potential damage to the
lake trout stocks as a result of parasitic phase lamprey. This criterion is
analogous to the maximum effect criterion of effects on lamprey (high
damage/stream => high rank).

4. efficiency (benefit/cost) of damage reduction: equivalent to criterion (2)
except measured in terms of the indirect (but primarily sought) impact on
the fish community rather than the direct impact on lamprey (high
damage/treatment cost => high rank).

5. environmental risk/damage: this incorporates those costs associated with
the effect of the treatment on non-target species and the costs of
remediation. These costs are added to the costs if the treatment,
increasing the overall cost and lowering the rank. This option can only be
used in conjunction with the "benefit" criteria (points 2 and 4 above).

You should always check the criterion setting before starting to define a treatment
schedule since the selected criteria will determine the order in which streams are
listed (ranked) in the treatment scheduler.
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Defining the Treatment Schedule

Once users have modified the scenario according to the general procedure described
above, they must develop a treatment schedule. LCSS allows users to interactively
schedule treatments by displaying the list of streams to be treated in priority order (as
defined by the selected ranking criteria), and a monthly calendar on which stream
treatments can be scheduled.

Treatments are scheduled for individual crews and a different calendar is maintained
for each treatment crew defined in the system database.

Note: in the current version, the displayed stream list includes all streams in priority
order, not just those which would normally be treated by a given crew. Therefore
when working with the system you may find it helpful to keep a reference list of
streams which would normally be treated by the different crews.

CosTING CONTROL PROGRAM

Users can create a treatment schedule, or they can conduct an automatic scheduling.
When carrying out an automatic schedule, LCSS calculates a "running" budget. The
cost of the scheduled program is determined by summing the default costs for the
individual stream treatments from the central database. The resource requirements
and associated costs are steam-specific. Travel costs to the deployment site are
considered separately from treatment costs. Depending on how the budget was
structured, the cost of each treatment is subtracted from the total budget or from
individual Great Lake budgets. Once all the available money is spent, no more
streams will be allocated for the particular lake.

MODIFYING A CONTROL PROGRAM

LCSS may be used to modify a control program, including those that are under way,
as a response to unexpected logistical or climatic factors that disrupt the control
schedule. Users can edit a treatment schedule to specify changes to the control
program with regard to either the selection of streams for treatment or to their
placement within the treatment schedule. This permits system users to explore the
mmplications of alternative treatment selections.

Long-term Runs

In addition to using the LCSS to develop and adjust short-term lamprey control plans,
it can also be used to generate long-term control scenarios. Users can compare
alternative treatment selection criteria for their long-term performance and can
generate the output needed to establish the form of the Lamprey Abundance (L) vs
Control..y curve for mput to EIL estimation procedures. The results from any one
scenario are used to define only one point on this curve which describes the
relationship between lamprey abundance and a range of control program budgets
(costs). Developing the L vs Control..y relationship for subsequent determination of
an EIL for any basin in the context of whole basin logistical and resource constraints
requires simulating the effect control strategies over a series of resource (cost) levels.
Scenarios must be run for a sufficiently long-term horizon so that an equilibrium
level of lamprey abundance may be determined from the last few years (e.g. 5 - 10)
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of the simulation. The estimates of equilibrium abundance of lamprey within any
basin, and the costs attributable to the basin can then be used to define L wvs
Controles .

The process of running long-term simulations is essentially the same as that
described above for using the LCSS to develop short-term program plans.

Instead of using the LCSS to define or edit a detailed treatment program (including
logistical constraints of crew availability and timing) you can use the Quick Schedule
option under the Edit Menu to create a list of streams for treatment in each year of
the scenario. This needs to be done only if you want to predefine the streams to be
treated. In a longterm scheduled scenario, only the streams specified in the scheduler
or Quick Schedule feature will be treated. The treatments applied are those selected
for the streams or the defaults.

Alternately, you may use the LCSS to run a longterm Resource Limited scenario.
When a Resource Limited scenario is run, the LCSS will automatically schedule
streams for treatment during each year of the scenario run according to their
treatment priority until resources are depleted.
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4.0 LCSS User Interface

General Overview

The IMSL Decision Support System is composed of two major elements: the
Lamprey Control Selection System (LCSS) and the IMSL Database Access Module.
This section of the help documentation describes the user interface of LCSS and
provides an overview of all menu commands and associated functions.

Throughout this documentation, certain formatting conventions have been used.

These are:
Font Face Description
italics screen or field name (including lists, tables, and columns)
bold italics command button
bold regular menu or submenu option
Contents
LCSS is a software application that has been developed to assist in the long- and
short-term management of sea lamprey in the Great Lakes.
From the Main Menu
File Menu
Edit Menu
LongTerm Menu
Graph Menu
Database Menu
Options Menu
Help Menu
Glossary of Terms
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LCSS Main Menu

The Main Menu gives you access to all parts of LCSS.

" Lamprey Control Selection System
File Edit LongTem Graph Database Options Help

= ul

The three buttons on the toolbar provide quick access to:
File|Select Scenario DB;

Graph|Run Results Setup; and

File|Exit.

Each of the submenus and associated functions are described below.

File Menu
The File Menu The following six submenus are available from the File Menu. EXxit closes the LCSS
contains all of the program.

scenario and data

management options.
New Scenario DB
Select Scenario DB
New Results DB
Select Besults DB

Srenano Management
Delete ElL: Hesults

Exit

New Scenario DB
Select Scenario DB
New Results DB
Select Results DB
Scenario Management
Delete EIL Results
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NEw SceNARIO DB

The New Scenario Database option is used to make a copy of the default scenario
database. The copy can then modified to create a new set of conditions and
parameters. The default scenario database includes the starting conditions for
lamprey in all basins, streams and reaches to be simulated; the available budget and
treatment resources; and detailed descriptions of the control treatments.

. Create New Scenario DB '

New Scenario DB Name:  MDB [¥ Create new results DB

. New Hesults DB Name: MDB

Lancel l

From the Create New Scenario DB screen, you are prompted to enter the name of the
new scenario and results databases. Enter up to seven characters in the appropriate
fields. When the “Create new results DB” box is checked, the name you entered for
the new scenario database is also entered as the results database name, except for the
prefix “S” or “R”.

SELECT SCENARIO DB

NEw REsuLTs DB

The Select Scenario Database option allows you to choose a pre-defined scenario
database to use for the simulation.

Select Scenario Database

I"é‘ﬂ Less

Look in:

Filename: i ; DOpen

o e |

~ Files of tupe: ]Scenario Files [s*.mdb}

The New Results DB option creates a new database in which to store the results of
the simulation. The results databases all begin with the prefix “R” to distinguish
them from the scenario databases that begin with the prefix “S”.
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iqi Create New Results DB B3
Newk'Results DE Name: IB .MDB

| ‘Qancaly l

Enter the name of the new results database and press OK.

SELECT RESULTs DB

Use the Select Results DB option to choose an existing results database in which to
store the results of the simulation.

Select Results Database ]

'Laok.in: . l\_cj Less

 File name: Fihis:t.mdb

Files of type: jHesults Files [r.mdb) _‘_’j Cancel ‘

SCENARIO MANAGEMENT

When implemented, the Scenario Management option will be used to delete
scenario and results databases.

DELETE EIL RESULTS

The Delete EIL Results option allows users to remove particular Environmental
Injury Level (EIL) run results from the EIL Run Results list.

% Delete EIL Results

EIL Run Results:

- 20% reduced budget
- 30% reduced budget
- 400% reduced budaet

- 10% increased budget
- 20% increased budget
- 30% increased budget

Clicking on Remove will delete the highlighted run from the list. Note that the
system routinely deletes old run results before re-running a budget.
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Edit Menu

The Edit Menu
contains all the
options for modifying
the parameters of a
given scenario.

The Edit Menu contains the submenus with which scenario parameters can be
modified. You are not required to specify all values for the current scenario, as
series of default values exists. However, you can modify and manipulate the default
values for existing scenarios by using the following options available from this
menu.

Scenaria Description
Budget and Resources
~ Banking Criteria
~ Treatment Schedule i
Quick Schedule

Stream Setup
Biclogical Parameters
- Lamprey Allocation
Traps

SMRT -

Basiry Population
Stream Population

ElL Bun Budgets

Scenario Description

Whenever a new scenario is created, you are asked to enter information
about the scenario's name, operator, and provide a full description of it
for future reference.

Budget and Resources

Use to enter and modify the budgets, resources, and resource costs for all
of the years within the calculation horizon.

Ranking Criteria

This option lets you select which ranking criterion will be applied when
streams are ranked for treatment.

Treatment Schedule
Ranks the streams and assists in the creation of treatment schedules.

Quick Schedule

This option allows you to quickly select streams for treatment and
implement a treatment schedule that uses the current default options.

Stream Setup

Provides important data about each of the streams in the database, such
as number, location, stream configuration, treatment and/or simulation
status, and stream barrier activity.
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Biological Parameters
Use this option to modify the lamprey model parameters.
L.amprey Allocation

This option is used to allocate spawners from basins to streams, and to
allocate transformers from streams to basins.

Traps

Use this option to simulate the placement of traps in streams and reaches.
SMRT

Defines the release of sterile male lamprey into streams.
Basin Population

This option is used to view/enter initial lamprey population values for
selected basins.

Stream Population

This option is used to view/enter initial lamprey population values for
selected streams.

EIL Run Budgets

Use this option to add, remove, and view budgets associated with
particular EIL runs.

SCENARIO DESCRIPTION

Describe the content
of the current
scenario using the
Scenario Description
screen.

In addition to the explicit option under the Edit Menu, the Scenario Description
screen appears whenever the nature of the current scenario is likely to have been
changed.

For example, when a new scenario is created (New Scenario, Save Scenario As...
options in the File Menu), the Scenario Description screen will activate.

w. Scenario Description ]

ScenarioName:  |Test scenario

Operator Name: |Miroslaw Kuc

~ Seenatio Descriptiory

{Test scenario with historical data.
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BUDGET AND RESOURCES

Each year of the
simulation has a
separate budget,
which is displayed
on the Budget and
Resources screen.

The Budget and Resources screen, accessed from the Edit Menu, is used to enter and
modify the budgets, resources, and resource costs for any year. Resources include
funds, crews, chemicals, barriers, SMRT, and traps.

%i. Budget and Resources ]

AdvinFoed  [s55470000  Year BooGe [IqTqTo000-1 B[]  Recalulsts |
ExtExp. W ~ New Year l DelYes l ]
Assessment  [goapigonon  Prev. Year Surp/Debt [sooo 2
R [5ioe160000  CurentYearBudgel  [§5500,000.00
Crew Cost $1.950.750.00 gewé ’ : ‘
_ Banier Cost [si35548 70 Avg Opesaling Cost [s1000000 Bariess l
SMRT Cost [0 - SMRTProduction [g CostUnt  [5743
TepCost  [s@o0  Teps |

. i ; Puichase  Amount Purchase Puschase Chem. .SJDCRI
el Used [kg) Ceiling (kg] Cost/Unit Total Cost

TFM Jsazgsnae2n 14236 - NoLim |$66.00 [$434,556.21
TrMBars  |$20.370.00 1485 ' ; ~Mobim [$4200  |$20.370.00
BayerWP {82815 76 |sB NoLim [$40.80 [$2.815 76
BayerGran.  [§0.00 Jo NoLim |$2370 |$0.00

' ) Pragram Cost
Progiam Cost:  [$3.049,040.10 Available - f¢5 333 644 00 finel. stock)
[ Eeep vears budget between runs Balance |2 284.603.90 |$3.049.040.10

Upon activation, the Budget and Resources screen gives the option to recalculate trap
costs. This needs to be done only when trap costs have been changed by the user (for
more information about traps, see page 4-46).

Generally, the fields in the top third of the screen represent known program costs
plus information about the budget year and total budget. The fields in the middle
third of the screen contain information on the cost of crews, barriers, sterile male
release (SMRT) and traps. These costs are calculated by LCSS based on the current
schedule. Details about the chemical control program are displayed in the bottom
third of the screen.

The option box at the bottom of the screen, Keep year's budget between runs allows
you to “set" user-entered budgets. As the simulation progresses, LCSS automatically
creates budgets from year to year, and deletes those budgets that were not set before
the run. When the Keep option is chosen, LCSS uses the latest Keep budget as a
default.

[@ In future versions of the program, different organizational units or institutional groups will
be able to set new budgets, as specified by the Budget Group category (top of screen). At
present, LCSS uses a single budget group to represent the Great Lakes Fishery Commission
Program for all lakes.
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LCSS holds detailed information only for budgets directly related to treating
lamprey. However, additional fields are provided that allow users to enter other
budget details. These are default administrative and fixed costs (Admin/Fixed),
extrancous expenses (Ext.Exp.), assessment costs (Assessment), and research and
development costs (R&D). These can be modified by simply typing in the new
amounts.

ng: Barrier extraneous expenses can be specified by selecting the Barriers command button
which activates the Stream Barriers screen (see page 4-28). From there, select extraneous
expenses (Ex. Expenses) to access the Extraneous Stream Barrier Costs screen (see page 4-
29).

» To enter a new budget:
1. Access the Budget and Resources screen from the Edit Menu.
2. Choose the year you wish to serve as a template.

3. Click on the New Year button and enter the new year. Modify the values
in the available fields as necessary.

4. Click OK to leave the screen and return to the Main Menu.

» To delete an existing budget:
1. Access the Budget and Resources screen from the Edit Menu.
2. Select the year for which you wish to delete the budget.

3. Click on Del Year and specify whether you want to delete budget
information only, or all information on the budget, crews and schedule
that was entered for the selected year.

4. Click OK to leave the screen and retumn to the Main Menu.

If you choose to delete only budget information, crew and schedule data will be
stored by the system until a new budget is entered or generated for that year.

Administrative and fixed costs

The fixed cost fields on the Budget and Resources screen include such things as the
current year's budget, the surplus or debt from the previous year, administrative costs,
extraneous expenses, assessment costs, and research and development costs. In the
first year of the program, you will need to enter the previous year’s surplus or debt
(Prev. Year Surp. Debt field), in subsequent years, you can choose to have this value
calculated automatically by flagging an option in the General Options screen (select
Options from the Main Menu, see page 4-64).

After you enter administrative and fixed costs for the selected year, you will need to
provide the system with further information about the crews, as well as the control
program for barriers, sterile male release (SMRT), traps, and chemical treatment.
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Basin

The Basin screen allows addition, removal, modification and selection of the lamprey
basin configurations. It also allows selection of the spawner allocation strategy to be
used in the next simulation (static vs. dynamic). This screen is the first of three
Lamprey Allocation screens.

w. Lamprey Allocation l

~ Basin ] Static Allocation i Dynamic Allocation i
Simulated Lamprep Basin Configuratior: -
1 Configuration Name | Description ~
0 Superior with 3 sub-basins
Superior-4 Superior with 4 sub-basins
- {Superior-1 Superior with 1 sub-basin
| Ontario-1 L. Ontario with 1 sub-basin

L édd ﬁemﬁwe ~

. Lamprey Basir
~{Lamprey Basin Name

TS West {= Siatic
Canada £~ Dynamic

The lamprey basin configurations subdivide the lake lamprey population into distinct
groups. Configurations can be added and removed by pressing the Add and Remove
buttons just below the list of configuration names. The name of the configuration
and the configuration description can be modified directly in the table. The
configuration selected upon exit from this screen will be the one used in the next
simulation. The Lamprey Basin field, located below with its own Add and Remove
buttons, lists the basins which comprise the selected configuration.

The selected basin configuration will affect the allocation of lamprey when running the
model. For example, if you choose a lamprey basin configuration that contains only Lake
Superior, you should not simulate streams from other lakes. The current lamprey basin
configuration is always displayed on the status bar at the bottom of the screen.

Also available on this screen is the option to select the spawner allocation strategy by
clicking on either the Static Allocation or Dynamic Allocation option buttons in the
Spawner Allocation field.
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Static allocation

Dynamic allocation incorporates dynamic criteria (e.g., ammocete count) into the
allocation in addition to static criteria. This approach allows exploration of criteria
for "attractiveness" of a stream to lamprey.

The Static Allocation screen contains parameters that govern the static allocation of
transformers from streams to lamprey basins and from lamprey basins to streams.
This screen is the second of three Lamprey Allocation screens. In static allocation,
the proportions of lamprey allocated from streams to basin and basin to streams are
fixed and are independent of changes in the streams (e.g., ammocete densities).

wi. Lamprey Allocation l

 Basin StaticAllocation | Dynamic Allocation |
Basmto-Stream Allocation
Leke | Stream | Basin . Allocation - afr Ordered By:
1 Canada 3.972865E-05 A% Basin
S 2 Canada B.268299E-05 |
5 2 Canada B 740304EGE |~ Steam
5 5 Canada 1.801032E-04 =
S 23 Canada b.B15735E.04 RO A
S 24 Canada 0.1058285 '
5 36 Canada 9 306883E 04
S 39 Canada 9.27002E-05
S 41 Canada 0.00015 Add
S 48 Canada 2.177043E-02 —
5 52 Canada 8.768646E-02 |
5 54 Canada T460918E 03 | Demove
S 56 Canada 1.073403E-02 :
5 53 Canada 0ooos | Synchionize
5 160 Canada 6.000007E-05 | ‘
5 116 Canada 0.0003 Normalize
g 167 Canada 9.000001E-02
5 202 Canada 0.00012 . | Alloc. Rule
5 3N Canada noaR.Y
oK

On the Static Allocation screen, the Allocation column of the Basin-to-Stream
Allocation table contains the proportion of all spawners in the stream's basin that are
allocated to the stream from the basin. Multiple basins can contribute spawners to
one stream. The total of all proportions for a particular basin should always add to 1
(see about normalizing the allocations with the Normalize command button, below).

Clicking the Switch command button switches the screen between basin-to-stream
allocation and stream-to-basin allocation. In the Stream-to-Basin Allocation table,
the Allocation field contains the proportion of a stream's transformers migrating to a
particular basin. Streams can contribute transformers to multiple basins and the total
allocation for any stream should add to 1.

The allocation proportions in the Allocation field can be modified either manually by
overtyping the values in the table or according to a static allocation rule (click the
Stat.Alloc. command button on this screen to access the Static Allocation Rule
screen; see below).
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Command buttons Add and Remove allow addition and deletion of streams from the
allocation list. Multiple entries in the stream-to-basin list allow splitting of the
contribution from a stream among multiple basins. Multiple entries in the basin-to-
stream list allow multiple basins to contribute spawners to a single stream.

Your selection of streams to be simulated can be synchronized with the stream-basin-
stream allocations by clicking on the Synchronize command button, which opens the
Synchronize Allocation screen.

SYNCHRONIZING LAMPREY ALLOCATION

NORMALIZE

. Synchronize Allocation

Bas‘in,'Co'nﬁg@uraﬁon: Superior-3

{5 Set simulated selection to allocated
 Settotie all of the "simulate” and et flags
_ [Stream Setup screen for sreams with allocation.

(‘ Sak allocated selec:bon to stmufated

Allocate spawners to and transformers from all of the:
-~ streams with the "simulate” flag set to tue using
the allocation wile). ' '

- Synchronize I

From this screen, choose one of the two available options:
. set simulated selection to allocated; or
. set allocated selection to simulated.

The first of these two options modifies the list of simulated streams to match those
with allocation, and the second modifies the allocation list to match the simulated
streams. Click on the Synchronize command button on the Synchronize Allocation
screen to initiate the synchronization process.

The Normalize command button on the Static Allocation screen invokes a function
that scans all of the lamprey allocation values. It ensures that the basin-to-stream and
stream-to-basin allocations add up to 1 (100%). Allocation values that have been
changed by the user are preserved, and the remaining values are scaled based on their
relative magnitudes.

For example, in a hypothetical basin there may be three streams: A, B, and C.
Suppose the original allocation was Stream A: 0.2; Stream B: 0.3; and Stream C: 0.5.
If the allocation to Stream A is altered to 0.3, and you select Normalize, the
allocation to Streams B and C would change to 0.2625 and 0.4375 respectively, thus
adding to 1.0.

In some instances, it may be impossible to normalize the allocation. This would
occur, for example, if all of the values for a particular basin in a basin-to-stream
allocation were user-entered. In a case like this, an error message would be displayed
when the user attempted to normalize the allocation.

Integrated Management of Sea Lamprey Decision Support Tools LCSS User Interface » 4-43



LCSS: User Guide

The normalization routine is automatically invoked upon exiting the Static Allocation
screen.

STATIC ALLOCATION RULE

The Static Allocation Rule screen can be accessed by clicking on the Alloc. Rule
command button on the Static Allocation screen. It allows entry and modification of
the allocation rule used to generate the static basin-to-stream allocation.

%. Static Allocation Rule ]
' e Allocation; '
>5 ur cucle, of not lately)

. [] Treated once in a whie
- 1{4] Residulal Populations [Not treated)

Add

et

Hemove

fenerate

Total r———__f oK

The static allocation rule is centered around stream classes (see about defining the
physical layout of a stream, page 4-24). These classes represent the "attraction" of
lamprey to streams. The Stream Class list contains all of the classes present in the
simulation. The static allocation rule allows the grouping of one or more classes and
the allocation of proportions (Total = 1) of basin spawners to these groups. Click on
one of the listed Allocation values to view the Stream Classes currently associated
with it. Modify the grouping by selecting or de-selecting stream classes with a click
of the mouse. The Add and Remove command buttons add and remove values from
the list in the Allocation field.

The Generate command button erases the current basin-to-stream allocation and
generates a new one based on the stream-to-basin values. The allocation within the
stream class groups is proportioned according to the spring discharge of the stream.
The same rule is used to calculate the basin-to-stream allocations for all of the basins
in the current lamprey basin configuration.

When there is more than one basin simulated, it is possible to have basins which
contain only a subset of all stream classes and a subset of stream class groups. When
this situation is encountered, the algorithm splits the missing group's allocation in
proportion to the values of remaining stream class groups. For example, if basin 1
contains streams with classes {1,2,3}, basin 2 contains classes {1,2,3,4}, and the
stream class groups are: A = {1,2}, B = {3}, and C = {4}, then for basin 1 the
algorithm splits the allocation for group C between groups A and B. When a stream
1s contributing transformers to multiple basins, the flow is apportioned to the basins
based on the stream-to-basin allocations and the stream receives spawners from each
basin based on the portion assigned to the basin.
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MODIFYING BASIN TO STREAM ALLOCATIONS

» To allocate spawners from a basin to a stream:

1. From the Lamprey Allocation option on the Edit Menu, select the Static
Allocation tab to access the Static Allocation screen. Ensure that the
name of the table reads Basin-to-Stream Allocation. If it doesn't, click on
the Switch button.

2. Identify the stream basins for which you wish to edit the spawner
allocation. (If you need to verify any stream numbers, go to the Stream
Setup option on the Edit Menu.)

3. Enter your new values (from 0 to 1) in the Allocation field across from
the associated lake and stream. Repeat steps 3 and 4 for all of the
streams you wish to modify.

4. Click on the Normalize command button. This function ensures that the
sum of all allocation values for any given basin remains equal to 1. The
normalizing procedure will preserve the values you changed, and the
remaining values will be scaled based on their relative magnitudes.

MODIFYING STREAM TO BASIN ALLOCATIONS

» To allocate transformers from a stream to a basin:

1. From the Lamprey Allocation option on the Edit Menu, select the Static
Allocation tab to access the Static Allocation screen. Ensure that the
name of the table reads Stream-to-Basin Allocation. If it doesn't, click on
the Switch button.

2. Identify the streams for which you wish to edit transformer allocation.
(If you need to verify any stream numbers, go to the Stream Setup
option on the Edit Menu.)

3. Enter your new values in the Allocation field across from the associated
lake and stream. For most streams, 100% of lamprey will be allocated to
a specific basin. However, for some streams located near the junctions
of two or more basins, a stream could contribute transformers to multiple
basins. In these cases, enter a value that indicates the proportion of
lamprey that should be allocated to the basin.

4. Click on the Normalize command button to ensure that the sum of all
allocation values for each stream remains equal to 1.
Dynamic allocation

The Dynamic Allocation screen allows the definition of the dynamic allocation rule.
It is the third of three Lamprey Allocation screens under the Lamprey Allocation
option on the Edit Menu.
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W Lamprey Allocation R ,,

B_asir)‘l‘ Static Allocation Dﬁnémﬁgﬁca&mq

AllociStieam] 1 ",.é.mrrﬁx‘Dyisdwarge

Di#éhérge: lg
L Ammocete Count: ’g'
, aﬁsmmbcete {Zm / Discharge: ]1 ' W; . :

Dynamic allocation is the second of two alternative strategies for allocating spawners
returning from basins to streams. It incorporates dynamic criteria (e.g., ammocete
count) into the allocation in addition to static criteria. This approach allows
exploration of criteria for "attractiveness" of a stream to lamprey.

Currently, there are three criteria supported:
. Discharge - stream spring discharge (a static criterion);
. Ammocete Count - total number of ammocetes within a stream; and
) Ammocete Count/Discharge - simulates "pheromone" concentration.

The dynamic rule can be any linear combination of these criteria. The rule is applied
in a fashion similar to the static rule. The static stream-to-basin allocation is used to
determine which streams will receive spawners from which basins, then the
allocation factors are computed based on the value of the combined dynamic
allocation criteria.

TRAPS

You can simulate the presence of traps in reaches by selecting the Traps option from
the Edit Menu, or by clicking on the Traps command button on the Budget and
Resources screen.

Two types of traps can be simulated: default and non-default. Default traps are
always associated with a particular stream barrier activity. When that activity
changes, the default trap is no longer present. For example, when the stream barrier
activity on Stream A is "no barrier", the default trap placement might be a trap placed
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below a particular reach. If the stream barrier activity changes to "barrier active",
however, the default trap is removed from the simulation.

Non-default traps are linked to a particular year in the simulation. For example, for
Stream A, a non-default trap might be defined for 1980. This means that the non-
default trap is present in the simulation from 1980 until the stream barrier activity
changes or until a new non-default trap is placed on the reach.

Default trap placement

Simulate the presence of default traps using the Default Trap Placement screen.

L & Default Trap Placement i

Lake: | Superior , x| Steam: |[10705]AMNICON RIVER |

 Stream Configurstion:  [Eiream wih barmer

Stream Barrier Activity: l no bariier or batrier not active

i

TrapEl {AnnDpCost {Barier
0.2] $2,000.00{Not on barrier,

Reach Descrption
2IBELOW NEW BAR -0LD WEIR | R [EEEIE]

Oyeview | Nondefat [ Copy | | Bemove | ok |

You can set the placement, efficiency, and cost of default traps with the fields and
command buttons available on this screen. They are:

Lake/Stream

These fields contain drop-down lists from which to choose the lake and
stream on which you wish to place a default trap.

Stream Configuration

This field shows the currently simulated stream configuration and cannot
be modified.

Stream Barrier Activity

You can select a stream barrier activity from the drop-down list in this

field.

Reach
This field contains a drop-down list of reach names for the currently
selected stream configuration.

Description
Enter a description of the trap in this field.

TrapEff
The value entered here (between 0 and 1) represents the efficiency of the
trap. For example, a value of 0.2 indicates that 20% of all lamprey
swimming by this trap (to the reach on which this trap is located and all
the reaches above it) are caught.
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AnnOpCost
Enter the annual operating costs associated with the trap.

Barrier
In this field you can specify the name of the barrier (if there is one) with
which the trap is associated.

Overview
Activates the Summary of Trap Activity screen which provides an
overview of the cumulative effect of default and non-default traps (see
below).

Non-default
Accesses the Non-default Trap Placement screen (see below).

Copy
Uses a "template" trap to create a new default trap.

Add
Inserts a blank entry for a default trap.

Remove

Deletes the currently selected default trap.

Simulating default traps

» To simulate the presence of default traps:

1. Select the Traps option on the Edit Menu, or clicking the Traps button
on the Budget and Resources screen, to open the Default Trap Placement
screen.

2. Choose the Lake, Stream, and Stream Barrier Activity for the stream
where the trap will be placed.

3. Select the Reach where the trap will be placed by choosing from the
drop-down list.

4. Add new traps using either the Add or the Copy button; delete selected
traps using Remove.

5. Enter a brief description for the trap, its efficiency (0 to 1), its annual
operating cost, and choose a barrier (if there is one) with which the trap
1s associated from the drop-down list in the Barrier field.

6. Click OK to save your changes and return to the Main Menu.

Non-default trap placement

Whereas default traps are associated with a given stream barrier activity, non-default
traps are associated with a specific year. You can simulate the presence of non-
default traps by clicking the Non-default button on the Default Trap Placement
screen which opens the Non-default Trap Placement screen.
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Non-default trap placements act in addition to traps placed in the stream by default.
However, when a stream barrier activity changes (and with it the default trap
placements), all of the non-default placements are reset.

. Non-default Trap Placement

Laker  Steam:

|[10018] ANKODOSH CREEK
1[10104] ANNA RIVER
[10901] ARROWHEAD RIVER
|[10110]AU TRAIN RIVER
{[10811] BAD RIVER
[52] BATCHAWANA
[10090] BEAVER LAKE CREEK |

 SoitOrder: @ Name © Number

- Nondefault Trap Flacement:
- [YearTrapDn]YeaTrap0it| Reach TrapEff} - Ann0OpCost
19801 [2IBELOW NEW BAR.-OLD WE! 0.3 $500.00
1975] 1980{[3ABOVE NEW BAR.-OLD WEIF 05 $500.00

You can set the placement, timing, efficiency, and cost of non-default traps with the
fields and command buttons available on this screen. They are:

Lake/Stream

Select the lake and stream on which you wish to place a non-default trap.
Sort Order

Sort the lake and stream lists either by Name or by Number.
YearTrapOn

The first year in which the trap is active.
YearTrapOff

The first year in which the trap becomes inactive.
Reach

This field contains a drop-down list of reach names for the currently
selected stream configuration.

TrapEff

The value entered here (between 0 and 1) represents the efficiency of the
trap. For example, a value of 0.2 indicates that 20% of all lamprey
swimming by this trap (to the reach on which this trap is located and all
the reaches above it) are caught.
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AnnOpCost

Add

Remove

Enter the annual operating costs associated with the trap.

Adds an entry into the Non-default Trap Placement table.

Deletes the currently selected entry from the Non-default Trap
Placement table.

Simulating non-default traps

» To simulate the presence of non-default traps:

1.

Summary of trap activity

Select the Traps option on the Edit Menu (or click the Traps button on
the Budget and Resources screen) to open the Default Trap Placement
screen. Click Non-default to open the Non-default Trap Placement
screen.

Select the Lake and Stream on which you wish to place the non-default
trap.

Add new traps by clicking on Add (or delete selected traps using
Remove).

Enter the year in which the new trap will become active (YearTrapOn
column), the year in which the trap will be removed from the simulation
(YearTrapOff column), the reach, the trap efficiency (0-1), and the
average annual operating cost of the non-default trap.

Click OK to save your changes and return to the Default Trap Placement
screen.

By selecting the Overview button on the Default Trap Placement screen, you can
view summary information about the cumulative effects of all defined trap
placements (defanlt and non-default) on the reaches of a particular stream.

The fields

on this screen show the simulation year, the lake, the stream number, and

the reaches (identified by number) of the stream. The values displayed in the reach
columns represent the cumulative effect of the default and non-default traps.

ik ’ Summary of Trap Activity ’ ' =i B3
[Superior R B 1705  AMNICON RIVER v

SimYear|Lake . Steam] 2 ‘ 3

5 10705 0.2 02

197015 10705 0.44 0.44

1975|S 10708 0.44 072

1980/S 10705 06 06

1990|5 1 0?05 0.2 0.2

This list of net trapping efficiencies is only for the steams cunentk:
- selected for stmulatmn , ._____JD'K

e
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The following example explores all aspects of traps and their placement, and
illustrates how cumulative trap efficiencies are calculated for each. In practice, it is
unlikely that users will encounter a scenario this complex.

The Amnicon River (Lake Superior) has two reaches numbered "2" and "3". From
1956 to 1969, the default stream barrier activity is "no barrier or barrier not active”,
and the trap efficiency is 0.2 (80% of lamprey are not caught). (To check these
values, look at the Default Trap Placement, Non-default Trap Placement, Stream
Setup, and Stream Barrier Activity screens). In 1970, a non-default trap is placed on
reach 2 with an efficiency of 0.3, trapping 30% of the 80% of lamprey getting
through prior to the 1970 trap installation. The cumulative impact of 1956 and 1970
traps 1s the sum of both efficiencies, i.e., 0.2 + (0.3 x 0.8) = 0.44 (56% of lamprey are
not caught). In 1975, a non-default trap with an efficiency of 0.5 is placed on reach
3. This trap catches 50% of the remaining 56% of lamprey getting through to reach
3. The cumulative impact of all trap efficiencies for reach 3 is therefore 0.44 + (0.5 x
0.56) = 0.72. Note, however, that the cumulative trap efficiency for reach 2 remains
at 0.44 because the trap placed on reach 3 has no impact on reach 2 which is
downstream of reach 3. In 1980, both non-default traps are disabled or removed and
the stream barrier activity changes to "barrier active” (see Stream Barrier Activity
screen) with a trap efficiency of 0.6 (see Default Trap Placement screen). Finally, in
1990 the stream barrier activity changes back to "no barrier or barrier not active" with
a trap efficiency of 0.2.

SMRT
Choose SMRT from the Edit Menu to access the Sterile Male Release Technique
screen. This option allows you to set the non-default release of sterile male lamprey
to any stream present in the database. The default release of sterile males is specified
on the Stream Barrier Activity screen.
. Sterile Male Relsase Technique i
Leke: Steam k Non-defauk Sterile Male Heleases:
SimYear SMCount SMRelRt
L [10705] AMNICON RIVER 2
[10018] ANKODOSH CREEK 1958 3
[10104] ANNA RIVER s T
[10301] ARROWHEAD RIVER
[10110] 40U TRAIN RIVER
}[10611] BAD RIVER
[52] BATCHAWANA
[10030] BEAVER LAKE CREEK 25
- [10027] BETSY RIVER =
- Sort Order. . :
05 Mame 0 Humber Hverasw ! Defauk 1 Add ! Remove i [11 4 l
The fields and buttons on the Sterile Male Release Technique screen are:
Lake/Stream
Select the lake and stream into which you wish to release sterile male
lamprey.
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BASIN POPULATION

Sort Order

Choose to sort lake and stream lists by Name or Number by clicking on
one of these option buttons.

SimYear
The year of sterile male release.
SMCount

The actual number of sterile male lamprey released.

SMRelRt
The ratio of sterile to non-sterile male lamprey. For example, an
SMRelRt of 2 means that 2 sterile males were released for every 1 non-
sterile male. If values for both SM Count and SMRelR¢ are entered, the
value for SMRelRt will be the one used by the system.

Overview
When implemented, this button will open a screen that will show a
summary of the impact of the SMRT program.

Default
Activates the Stream Barrier Activity screen where you can enter/modify
the default sterile male release counts or ratios for any of the stream
barrier activities in the current stream configuration. EXxit returns you to
the SMRT screen.

Add
Adds release entries for the currently selected stream.

Remove

Deletes release entries for the currently selected stream.

For each stream, the following information is displayed: the simulation year, the
SMCount (the actual number of sterile males that are released) and the SMRelR¢ (the
ratio of sterile to non-sterile males).

Non-default SMRT values are associated with a particular simulation year. Values
will only apply to the currently selected stream configuration. If you decide to change
the stream configuration, the SMRT values will change to the default values
associated with the new stream configuration (as specified on the Stream Barrier
Activity screen) and you will have to enter a new release schedule. If you re-select the
old stream configuration in a later simulation, the schedule you chose earlier will
apply once more.

Select the Basin Population option from the Edit Menu to open the Basin
Population screen. Use this screen to view/enter lamprey population values (e.g.,
number of transformers) for each of the lamprey basins in the currently selected basin
definition. To make changes, simply click on the field to be modified and type in the
new values.
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. Basin Population I

Current basin definitior; Superior-3
. Subrbasin in the current basin defn:‘ !Canada :J

} Transformers ~ Paasiic Phase

Spawners

Year o Count PropFem . Lount} - PropFem Cournt PropFem

9 40000 0.52 20000 0.52 20000 0.52
15958 75636.91 0.52 28000 0.52 20000 0.52
1959 74204.05 0.52 52945 83 052 28000 052
1960 243260.2 0.52 51942.83 0.52 5294583 052
1961 561694.1 0.52 170275.2 052 51942.83 052
1962 733908.9 0.52 393185.8 0.52 170275.2 0.52
1963 5443893 0.52 517936.3 0.52 3931858 052«

' Add Year DelYear

Values entered in this screen constitute initial population conditions for a particular
year and will be used by LCSS to run the simulation for the next consecutive year.
For example, if you enter initial stream population data for 1987, these will form the
basis for a simulation run of 1988 conditions.

The fields and buttons on this screen are:
Current basin definition

This field identifies the currently selected lamprey basin definition. This
entry cannot be modified here. To change it, go to the Lamprey
Allocation option on the Edit Menu (see page 4-41).

Sub-basin in current basin defn

Allows you to select the specific sub-basin for which you wish to
view/enter population data.

Year

This field identifies the year to which the data apply and it cannot be
modified.

Transformers Count
The number of transformers in the basin
Transformers PropFem
The proportion of the total transformer count that is female.
Parasitic Phase Count
The number of parasitic phase lamprey in the basin
Parasitic Phase PropFem
The proportion of the total parasitic phase lamprey count that is female.
Spawners Count

The number of spawners in the basin
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Spawners PropFem
The proportion of the total spawner count that is female.
Add Year

Enter data for a new year. You will be prompted to enter a specific year.
A default set of population values for the new year will be automatically
entered into the Basin Population table. Modify as appropriate.

Del Year
Deletes the selected row of data.

STREAM POPULATION

Select the Stream Population option from the Edit Menu to open the Stream
Population screen.

&, Stream Population ‘
Leke: | Superior =] Steam: | [10705] AMNICON RIVER |
Year| Reachi Age AmmSury AmmDen|- Ammlen TransYear a
< 1 0 5 30 1]
1957 1 1 2 50 0
1957 1 2 0.65 80 0
1957 1 3 0.325 100 0
1957 1 4 0.18 115 0
; 1957 1 5 0.08 130 1
1957 1 6 0.025 140 2
. 1957 1 7 0.005 150 3
1957 1 8 1] 160 4
o —— . —
Size Classes Add Year l DelYear i

The Stream Population screen is used to view/enter ammocete population values
(i.e., ammocete density, length, and transformation year) in the currently selected
stream. Data are organized by year, specific reach, and lamprey age.

Values entered in this screen constitute initial population conditions for a particular
year and will be used by LCSS to run the simulation for the next consecutive year.
For example, if you enter initial stream population data for 1987, these will form the
basis for a simulation run of 1988 conditions.

The fields on this screen are:
Lake/Stream

Select the lake and stream for which you wish to view/enter ammocete
population values from the drop-down lists in these two fields.

Year

This field identifies the year to which to the data apply. It cannot be
modified.
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Reach
This field shows the number of the reach to which the data will apply. It
cannot be modified.

Age
Lamprey age (from 0 to 8 years) appears in this field and cannot be
modified.

AmmSurv
Ammocete survival is expressed as the proportion of each age class
surviving the year. AmmSurv is a calculated value dependent upon the
total ammocete density and the shape of the SLP curve (see page 4-40).

AmmDen
Ammocete density is expressed as number of individuals per square
meter (#/m°).

AmmLen
Ammocete length is expressed in millimeters (mm).

TransYear

This field describes the stage of transformation for lamprey in each age
class (see section Simulating Transformation to the Parasitic Phase in
Appendix A).

The actions available on this screen are:
Size Classes

Clicking on this command button activates the Stream Ammocete
Number by Size screen (see below). Use this screen to view/edit a graph
of the number of ammocetes against ammocete length for the selected
year, lake, and stream.

Add Year

Data can be entered for new years and for specific reaches by clicking
this command button, which launches the New Population Records
screen.

Del Year

Records for a specific year and reach can be removed from the Stream
Population screen using this command button. Highlight any row of data
in the year and reach you wish to delete, and click Del Year. All records
for that reach in that year will be deleted.

STREAM AMMOCETE NUMBER BY SIZE

Clicking on the Size Classes button on the Stream Population screen activates the
Stream Ammocete Number by Size screen.

Integrated Management of Sea Lamprey Decision Support Tools LCSS User interface « 4-55



LCSS: User Guide
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The sizes of ammocetes (expressed as length in millimeters) are stored in the system
as means for each age class.

The fields across the top of the screen identify the Year, the Lake and the Stream for
which the data are displayed. Listed on the right side of the screen is a set of
standard deviation values which can be entered/modified for each age class and will
directly influence the smoothness of the size distribution curve. The system stores a
single set of standard deviation values for all streams in the database. Each time the
user makes changes to these values in the Stream Ammocete Number by Size screen,
the modified set will replace the previous set stored by the system. The last set of
standard deviation values used is always the one displayed, no matter which stream
has been selected in the Stream Population screen.

Graphs generated here show ammocete number on the vertical axis and ammocete
size (mm) on the horizontal axis. The “granularity” of the horizontal axis can be
controlled by specifying Interval Start and Interval Length values. The best results
can be achieved by setting these two parameters to the same value, eg., 2
millimeters. The upper range for size is determined automatically to include the
largest lamprey in the simulation plus three standard deviations. To refresh the graph
display following modifications to any of these fields, click on the View command
button.

Values entered in this screen are for display purposes only and will not affect the
simulation.
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NEW POPULATION RECORDS

The Add Year button on the Stream Population screen activates the New Population
Records screen.

f % New Population Records I

 Lake: Superior

 Sueam: [10705] AMNICON RIVER |

Reach [HIENTIRE SYSTEM ~]

Year ﬁﬁ'—— -

The Lake and Stream fields identify the currently selected lake and stream. Choose
the year and specific reach you wish to add to the Stream Population table and click
OK to return to the Stream Population screen. Modify the values for ammocete
survival, density, length and transformation year by overtyping the current values
with new ones. Repeat this process for each reach you wish to add.

[@: When a new reach is created using Edit|Stream Setup, the system adds it to the list of
reaches in the Stream Population screen. The reverse, however, is not true. The Del Year
function in the Stream Population screen deletes only the lamprey population information
associated with the selected reach and not the physical reach itself. To delete a reach
altogether, you must use the Physical Reach Parameters screen in Stream Setup.

EIL RuN BUDGETS

Selecting the EIL Run Budgets option from the Main Menu activates the E/L Run
Budgets screen. This screen allows the user to modify budgets for existing runs, to
create new run budgets, and to delete existing run budgets.

. EIL Bun Budgets
Cunently Defined EIL Run Budgets:

{Description

. Base Bun - full budget
110% reduced budget
- 120% reduced budget

130% reduced budget

140% reduced budget

{10% increased budget

{20% increased budget

130% increased budget

40% increased budget

50% increased budgst

i.1 00% increased budget »

Add Remove View
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Budgets store information for the whole (5 lake) basin. If only one lake is run at a
time, e.g., current BasinDef set to Ontario-1 (Lake Ontario, one sub-basin), make
sure that the appropriate proportion of the budget is used (e.g., one fifth). To set the
proportions of each of the resources to be used in the run, go to the LongTerm
option on the Main Menu. If you wish to change the basin definition for a run, go to
the General/Basin Parameters screen in Edit|Biological Parameters or to the Basins
screen in Edit|Lamprey Allocation.

The fields and buttons on the EIL Run Budgets screen are:
Currently Defined EIL Run Budgets

Contains a list of existing run budgets. You can edit the name of a
budget by typing in a new Description.

Add/Remove

Use these command buttons to create new run budgets and to delete
existing run budgets.

View

This command button activates a screen that is structurally identical to
the Budget and Resources screen, where you can modify the values in
existing run budgets, e.g., total budget amount, the cost of crews, SMRT,
barriers, traps, and chemicals. When editing the values, careful
consideration of the number of crews assigned to the job is important.
Be aware that in lower budget scenarios, there may be insufficient money
to support all crews as well as to treat streams. At higher budget levels,
there may not be enough time for assigned crews to do all of the potential
work. The user must define the crew details that are appropriate for the
time and money allocated in the budget.

» To modify an existing EIL run budget:

1. Select the EIL Run Budgets option from the Edit Menu to access the
EIL Run Budgets screen.

2. Highlight the run you wish to modify and click on the View command
button. This action activates the Budger and Resources screen where the
current values for the selected budget are displayed.

3. Modify by typing the new values into each of the fields you wish to
change.

4. Click OK to save your changes and return to the Main Menu.

» To create a new EIL run budget:

1. Select the EIL Run Budgets option from the Edit Menu to access the
EIL Run Budgets screen.

2. Click on the Add command button to add a new budget to the list. You
will be offered the opportunity to use the currently highlighted budget as
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a template for modification. Alternatively, you can choose to create a
new, blank budget.

Provide a name for the new budget in the Description field.

Click View to activate the Budget and Resources screen where you can
modify/enter the budget values in each of the available fields.

Click OK to save your changes and return to the Main Menu.

» To delete an existing EIL run budget:

1.

LongTerm Menu

Select the EIL Run Budgets option from the Edit Menu to access the
EIL Run Budgets screen.

Highlight the budget you wish to delete.

Click on the Remove command button. You will be prompted to confirm
your deletion request.

Click OK to save your changes and return to the Main Menu.

LCSS can generate long-term control scenarios to help you evaluate the long-term
performance of alternative selection criteria and budget limitations. To conduct a
long-term run, select the LongTerm option from the Main Menu to access the Long
Term Runs screen.

W Long Term Runs I

5 tart Year
. EndYear

{1938

ﬂ 2000 H

%fnggnType

| C Resource limited , A Bl Sheams

Chem. Opt. te-evatation——

‘ {: Scheduled Treatmant$§ " Barrier Steams Only ‘

. {‘. ﬁﬁiﬁ?ﬁaiic ?;C?‘ﬂaéuir? {: N’o re.e\.«aluaﬁon

_  Spawner Allocation:
| % Static

| ¢ Dynamic

Resources

I~ EiLRun [Re#aurce Limited) \
T~ Compact Database before run S oK

Run

The fields, options, and buttons on this screen are:
Start Year/End Year

The dates entered in these fields identify the calculation horizon for the
run.
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Run Type

Select the type of run you wish to conduct using the option buttons in
this section of the screen. There are three run types:

e Resource Limited runs erase the existing schedule, and select streams for
treatment in priority (as determined by the ranking criteria), using the
availability of chemicals, time, and money as the only limitations;

o Scheduled Treatment runs apply the current schedule for the range of
years shown; this is done on a year-by-year basis when moving forward
through the schedule; this option can be used for applying historical
treatments; and

e when implemented Automatic Schedule runs will erase the current
schedule and use the built-in expert system to build a treatment schedule;
this option will add logistic constraints to the suite of limitations
examined in the Resource Limited runs, and will be the same as clicking
the Gen All button on the Treatment Schedule screen.

Chem. Opt. re-evaluation

The three option buttons in this section of the screen are: All Streams;
Barrier Streams Only; and No re-evaluation.

Spawner Allocation

Select one of two options for spawner allocation strategy: Static or
Dynamic.

EIL Run (Resource Limited)

Checking this box expands the screen to include the list of Defined EIL
Run Budgets, and Run Type automatically defaults to Resource Limited.

% Long Term Runs

Statyes  [1998 Lo E Defined EIL Fiun Budgets:
Endvear  [2000 , -  [Base Run - full budget

10% reduced budget
20% reduced budget
30% reduced budget
40% reduced budget
{10% increased budget
20% increased budget
130% increased budget
40% increased budget
502 increased budget
1100% incieased budget
E 50 reduction budaet
100% reduction budget

. I Compact Database belore run . - Afgerage Last ]20 ymars

The EIL Run option also automatically turns off the Write Simulation
Details fo the database option and tumns on the Recalculate the ranking
list each year option during the run (see page 4-64). One or more EIL
budgets can be included in a single run, and each will add information to
the already generated data set, i.e., there is no need to run all defined EIL
run budgets in a single run.
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Compact Database before run

Check this box if you wish to compact the database prior to conducting a
long-term run. Compacting can be disabled if a run is extended for a few
years.

Resources

This command button activates the Long Term Runs Resource
Limitations screen (see below). Use this screen to specify how much of
each resource (e.g., money, chemical, person-days) is to be used in the
simulation run.

Run/Stop Run

Click on the Run command button to initiate a long-term run; during the
run, a Stop Run command button will appear. Stop Run allows you to
interrupt a long-term run. If you click on this button, the system will
finish the current year's calculations and then stop. The Start Year field
will be automatically updated to one year after the last simulated year.
To continue the run, click on the Run command button again. The
results of a run can be viewed in Microsoft Access by choosing
Database from the Main Menu.

Limiting resources in a long-term run

The Resources command button on the Long Term Runs screen accesses the Long
Term Runs Resource Limitations screen.

t . Long Term Runs Resource Limitations

~ Select proportions of each of the resources to be used in the current simulation.

... . ; FY: 1398
 Money: TN " [5063863 1405840
Person-days; — '].434?1 ~n ; 145.2582

v I [&ms o

TFM Bars: = [2585153 o
 Bayer Granular: [N , ].5502183 s
;}Bayg:w&z Poc: | o ki.5851528 0

Resources can be limited to simulate a reduction in overall resources (e.g., budget)
for all of the Great Lakes or to simulate only a part of the Great Lakes system (e.g.,
only Lake Superior).

The screen shows a list of all resources used in the simulation. A shaded proportion
of the bar next to the resource name represents the proportion of the resource
available. A numerical value of the proportion follows the bar. On the far right is the
amount of the resource available for the first year of the simulation. The limitations
specified apply to all of the years of simulation. To limit the availability of resources
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you can either click on the bar at the desired resource level or enter the proportion

directly.

Conducting a long-term run

» To conduct a long-term run:

1.

Graph Menu

Choose LongTerm from the Main Menu to open the Long Term Runs
screen.

Enter Start Year and End Year to set the calculation horizon.

Select the desired run type by clicking on one of the two available option
buttons: resource limited or scheduled treatments.

Select the optional EIL Run and Compact Database if so desired.

Indicate which spawner allocation strategy and chemical option re-
evaluation you wish to use.

Click on the Run command button.

To view the results of the run in Microsoft Access, go to the Database
option on the Main Menu.

The Graph menu provides for a visual review of many of the setup and results data
for LCSS runs. There are two main components to this menu: Run Results Setup and
Run Results View.

The Run Results Setup screen is activated by selecting Graph from the Main Menu,
or by clicking the graphing icon on the toolbar.
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 Run Results Setup l

_ Graphs (select one o more).

Total Transformer Production

_ 1Avg Unweighted] Amm. Density Dep. Survival
Total Spawn Run Size

Total Parasitic Phase Lamprey Population
Curent Basin Definition L vs C

Mean Amm. Density by Age for a Sheam

Total Amm. Density By Year for a Stream

- | Total Amm. Number By Year for a Stream
{Age Spec. Amm. Density By Year for a Stream ‘
r.ge Specific Amm. Number By Year for a Stream ,5 ‘

Tt Amm. Den. By Year Age >= 1 for a Stream
Tt amm. Num, By Year Age >=1 for a Stream
Total Transformer Production for a Stream
Patential Transformers for a Stream

' Observed Parasitic Phase Lamprey Population
Total Number by Basin

& Sidebpside - ~ Combined @

This screen features a list of graphs available for display, and includes the option to
choose display type. Select one or more graphs for display from the list in the
Graphs (select one or more) field. Choose the type of display desired by enabling
either the Side-by-Side or Combined option buttons. Graphs selected for display as
overlays must all be of the same type (e.g., all bar graphs) and have the same
independent variable. Graph type can be changed (e.g., from line to bar) only
through the native Microsoft Access Interface (see Appendix C). Additionally, if the
magnitude of the dependent variable for one graph in an overlay is substantially
different (i.e., more than 10 times) from another being displayed concurrently, the
data for the lower magnitude graph will be scaled automatically to the larger one
(e.g., Transformer Production (in the 1000s) vs. Ammocete Survival (<1)).

For all graphs involving density (e.g., Age Specific Ammocete Density), the unit of
measurement is number per square metre (#/m°).

After choosing one or more graphs from the Graphs list, click on the View Graphs
command button to initiate the graphing process.
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. Run Results View Y ]

Total Number by Basin

8000001

1957 1961 1971 1981 i3]

The system will request additional information as it compiles the data for each graph.
You will be prompted to identify the time period, and to identify the lake and stream
(stream number is required) for which you wish to graph data. If you need to verify
any stream numbers, go to Edit|Stream Setup.

When the system has finished generating the requested graphs, the Run Results View
screen will open to display the results. Legends for each graph can be turned on and
off by right-clicking with the mouse on the graph.

Database Menu

Choosing Database from the Main Menu accesses the Microsoft Access database
that contains the central files used in LCSS. From Microsoft Access you will be able
to enter data and generate results from the database.

Options Menu

Selecting Options from the Main Menu activates the LCSS Options screen where
you can set preferences for the system as a whole.
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\ LCSS Options - l
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The fields and options on this screen are:

Travel threshold

The maximum time between events for the same trip is used in the
scheduler to determine if a treatment or user event is a candidate for
inclusion in a trip. If an event is dropped within the threshold of another
event, the scheduler gives users the option of combining two events into
a single trip, thus representing a single trip time to and from the site.

Min. Break Length

The minimum break length between treatments is used for overtime
calculations. If this amount of time is not spent, the two events are
considered "adjacent" and their time is combined for overtime
calculations. If the length of such combinations exceeds 10 days, any
excess time is considered as overtime.

Recalculate budget

Check sur

When this option is selected, the budget is automatically recalculated
whenever a budget is entered.

plus/debt

This option provides continuity between years in terms of money and
stock levels. Enabling this option may not be appropriate when such data
are missing or incomplete.
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Help Menu

Base year

This is the base year used in the budget, treatment scheduler, quick
schedule options, and long-term runs. The value changes here whenever
it is changed in the Long Term Runs screen and vice versa.

Highest Age Class

Set the age of the oldest lamprey to be used in the simulation (the
maximum allowable is age class 10).

Write Simulation Details to the database

When this option is enabled, the system will copy the details of the
current simulation (e.g., lamprey numbers, density, length, allocation to
reaches) into the database. If you wish to run simulations for any years
following the year you are currently running, you must turn on this
option. If you plan to run the same year repeatedly to test the effects of
various parameter values, leave this option disabled so the run will
proceed more rapidly.

Recalculate the ranking list each year

If you enable this option, the system will re-assess the order in which the
streams will appear in the Ranked Stream List (Treatment Schedule
screen). Turning on this option will slow the speed of the run somewhat.

Help 1s available in two ways: through the Main Menu and from each screen. The
help provided through the Main Menu is indexed for easy reference and can be best
used for getting an overall view of the system, and for finding out about specifics of
the program's operation.

The help available from the screens is context sensitive and is related directly to the
options available from the screen. This type of help can be invoked using the <F1>
key while using the system.

The information presented through both options is identical. The index presents a
top-down view of the system, beginning with general topics and moving to more
detailed information about LCSS. The context-sensitive help goes directly to the help
topics most relevant to the current screen.

The help files follow the standard Microsoft Windows Help format.

4-66 o LCSS User Interface Integrated Management of Sea Lamprey Decision Support Tools



LCSS: User Guide

Glossary of Terms

EIL

LAMPREY BASIN

REACH

SCENARIO

Environmental Injury Level.

A lamprey basin is the area of a lake where a single parasitic phase population of
lamprey resides. It is defined by both the set of streams to which spawning phase
lamprey migrate and the set of streams from which transformers migrate.

A reach is defined as a non-overlapping section of the stream that acts as a
homogenous unit. Each stream that is potentially subject to lamprey control
treatments has been defined as consisting of a set of one or more reaches.

A scenario represents a set of conditions that are being simulated by the model, and
includes parameter values, management options and results. Scenarios include the
starting conditions of lamprey populations for all basins, streams and reaches to be
simulated; the budget and treatment resources that are available; and detailed
descriptions of the control treatments to be simulated by the LCSS.

STREAM BARRIER ACTIVITY

The stream barrier activity defines what happens in the stream over the course of the
simulation by determining the proportion of the stream's spawners allocated to each
reach. For example, a stream might be divided into two reaches as a result of a
potential barrier. If a simulation starts before the barrier is active (stream barrier
activity = "no barrier or barrier not active"), spawners have free access to the entire
stream according to the allocation associated with the stream barrier activity. When
the barrier becomes active (stream barrier activity = "barrier active"), spawner access
to the stream will be restricted to the lower reach only according to the spawner
allocation associated with the new stream barrier activity. If a barrier gets washed
out, spawners will once again have full access to the stream's reaches (stream barrier
activity = "no barrier or barrier not active"). The barrier activity will determine the
default values for chemical options, sterile male release, spawner allocation, and trap
allocation.

STREAM CONFIGURATION

A stream configuration is a definition of the physical layout of the stream. It is
composed of non-overlapping sections of the stream called "reaches", which act as
homogenous units. A combination of reaches that represents the whole of the stream
available for treatment is called the stream configuration. A single reach may belong
to multiple stream configurations. A stream can have multiple alternate stream
configurations, although only one can be used in the course of a single simulation.

TREATMENT WINDOW
Each chemical treatment option is assigned one of three treatment window types.
These are: preferred, acceptable and not acceptable. Future versions of LCSS will be
Integrated Management of Sea Lamprey Decision Support Tools LCSS User Interface « 4-67



LCSS: User Guide

able to show the assigned treatment window in the calendar when you check the
Show Treatment Windows box (bottom left comer of the Treatment Schedule

screen).
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5.0 ISIS User Interface

IMSL Stream Inspection System (ISIS) is a component of the IMSL suite of decision
support tools. The central theme for ISIS is the stream. ISIS was designed to easily
access and modify stream parameters and examine the effect of these modification on
the results of simulations.

This facility, however, would not be very useful without close ties with LCSS
(Lamprey Control Selection System). ISIS and LCSS share the simulation model,
including the stream treatments sub-model. ISIS is also able to import and export
stream parameters to and from any LCSS scenario database. This allows ISIS to
become a test bed for parameter values. ISIS keeps its own copy of the parameters to
allow LCSS to be used independently without fear that the parameters in LCSS will
change unexpectedly.

Additionally, ISIS allows comparison of the results of stream simulations to the
collected assessment data for individual years or over a period of time. This allows
refinement of stream parameters which then can be used in LCSS.

ISIS has four major components:

1. Data maintenance and I/0O allows users to import data from LCSS, create
streams, delete sets of parameters or delete results no longer needed.
These options are located in the File Menu;

2. The Stream construction component allows modification of a selected
stream. All stream parameters are available for review/modification in
the Edit Menu;

3. Model utilizes the values of stream parameters stored in the database to
run the lamprey model (see Model Menu section, page 5-23); and

4. Results review allows comparison of results of model runs using single
or multiple streams to each other and to the assessment data using tables
and graphs (also Model Menu).

Note: ISIS is still in a prototype stage and not all of its functions are fully
implemented. This document describes the program's current and intended functions.

ISIS Main Menu

The Main Menu gives you access to all parts of the system. Menus and submenus
are described below in separate sections. In addition to the main menu, there is a

integrated Management of Sea Lamprey Decision Support Tools ISIS User Interface ¢ 5-1



LCSS: User Guide

File Menu

button bar located just below the menu which provides fast access to the most
frequently used functions of ISIS.

IMSL Stream Inspection System

Fle Edt Model Window Help

|D @ X8 B 4l

The functions provided through the button bar are (in order):

from the File Menu:
*  New Stream Scenario
»  Select Stream Scenario
*  Delete Results Scenarios
* LCSS Scenario DB Import
* LCSS Scenario DB Export
from the Edit Menu:
+  Stream Parameters
from the Model Menu:
*  Run
*  View Results

A detailed description of the functions listed can be found under individual menu
sections.

The bottom of the screen identifies the currently selected stream. This choice can be
changed using menu items New Stream Scenario, Select Stream Scenario or by
selecting a stream in the Stream Parameters set of screens.

The File Menu contains the data maintenance and I/0 functions. The options most
often used are also present on the button bar.

New Stream Scenario ;
Select Stream Scenario

£S5 Scenaﬁo DB Import
‘LLCSS Scenano DB Export

; Qe?ete Stieam
. Delete Hun Result

E&t

New Stream Scenario creates a new stream either with default parameter values or
with a copy of parameters from another stream.
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Select Stream Scenario opens an existing stream for manipulation. This same
function can also be performed by selecting a stream in Edit|Stream Parameters
(see page 5-5).

LCSS Scenario DB Import and LCSS Scenario DB Export allow movement of
parameters between the ISIS database and the LCSS Scenario database.

Delete Stream allows the removal of stream parameters and run results for a
particular stream from the ISIS database.

Delete Run Result deletes individual run results for the current stream.

The Exit option shuts down the ISIS program.

LCSS SceNARIO DB IMPORT

ISIS provides a facility for importing data from the LCSS database. Selecting the
File[LCSS Scenario DB Import option activates the Import Stream screen. This
function can also be accessed from the button bar using the f@] icon.

&, Import Stream B 1

LESS Database name:
JE\Program Files\LCS §3Shist.mdb

Lake:

{[10018] ANKODOSH CREEK
[10301] ARROWHEAD RIVER
[10110] AU TRAIN RIVER
[10611] BAD RIVER
[52] BATCHAWANA
[10090] BEAVER LAKE CREEK
[10027] BETSY RIVER
|i5181G CaRP |

 Sort Streams By: & ¢ Number

The import function copies all of the stream-related parameters from the specified
LCSS Scenario and the associated Options databases to the ISIS database. These
include physical parameters (i.e., stream configuration, reach and age), barriers,
stream activity, spawner allocations, chemical options, treatment schedule, SMRT
and trap data, and stream-basin-stream allocation data.

To avoid the possibility of conflicts, currently loaded stream-basin-stream allocation
data are deleted prior to loading a new set of values. This may cause some streams to
behave differently following the loading of an unrelated stream (due to different
survival rates of parasitic phase lamprey and different proportions of returning
spawners, see the Spawners tab (page 5-21) of the Stream Parameters set of
screens.
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LCSS ScENARIO DB EXPORT

The LCSS Scenario DB Export function complements the import function
described above. It allows transfer of parameter values from the ISIS database to
LCSS database. The Export Stream screen can also be activated from the button bar
using the g3 1

DELETE STREAM

Use the Delete Stream screen to remove the parameters and run results for selected
streams from ISIS.

. Delete Stream I

Lake: {515 Streams:
10705] AMNICON RIVER

Sort Streams By:  Name " Number
Delete QK

DELETE RUN RESULT

The Delete Run screen allows you to remove particular run results from the list of
Run Data Sets. Select one or more runs and click on the Remove command button to
delete the highlighted runs from the list.

& Delete Run 1

~ Hun Data Sets (select one or more]:
- {[0 BOJANCASTER CR.1358-1990 sdf

5 10705] AMNICON RIVER 19581990 11/25/96 5:04:47 PM
[S 10705] AMNICON RIVER  1958-1390 11/27/96 2:49:00 PM

- CompactDB  Remove
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Edit Menu

The Edit Menu contains the stream parameters that characterize each stream. The
only option, Stream Parameters, invokes a set of screens containing nine tabs.

- Stream Parameters *

STREAM PARAMETERS

The Stream Parameters dialogue provides access to all stream-related parameters.
These are grouped into nine tabs placed along the top of the dialogue. Most of the
tabs contain layouts similar to those used in LCSS (see the LCSS User Interface
section of this manual). This family of screens can be activated from the button bar
with the [ icon. The nine tabs are:

Stream Contains the general stream information. A stream selected here is
later simulated in 1SIS. The current selection is reflected at the
bottom of the main screen.

Config Contains parameters defining the physical structure of the stream.

BioParms Contains biological parameters. A tabbed dialogue further
subdivides the parameter set in this screen.

Barriers Contains all of the currently defined barriers on the stream . and
facility for deleting or defining new barriers.

Acrtivity Contains the definition of the way the stream acts in response to the
activation and/or failure of barriers. Here you can also access the
chemical options and the default SMRT release settings.

Traps Allows definition of default and non-default trap placements.

SMRT Allows definition of overrides for the default SMRT releases
(defined in the Activity tab).

Spawners Defines the annual allocation of spawners to the stream.

Treatments Lists and allows modification of all of the chemical treatments
selected for the current stream.

Each of these tabs is described in more detail below.

Stream
The Stream tab contains a screen that is very similar to the Stream Setup screen in
LCSS (see page 4-22). It contains general information about the streams loaded in
the ISIS database.
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| &% Stream Parameters ]

Config | BioPams | Bariers| Activity| Traps| SMAT| Spawners] Treatments|
' Currently Simidated Stieam Configuration:

10705] AMNICON BIVER 415] Single reach stream
[10104] ANNA RIVER 445] Stream with barrier

SotStieamsBy: % Name £ Number

- Steam Lode: ]705 W Simdate W Teat . |V Default Chem Opt Only

Latitude: ] . State/Prov. ! Hudos
Longitude: ] : Country iUSA '

 Class | [1]Prime Prod. (45 yr cycle) ~i

The Lake and Stream lists allow selection of a stream to be simulated, viewed or
modified. The stream list contains only the streams loaded into the ISIS database.
As streams are added to or removed from the database, the list will change
accordingly. The Stream list can be sorted by either the stream Name or Number.
The stream selection made here is displayed on the status bar at the bottom of the
screen, and is the one that will be used for simulation runs. It will also be the
currently selected stream in all of the tabs in the Stream Parameters family of
screens.

The Currently Simulated Stream Configuration list displays all of the currently
defined physical representations of the selected stream. The one currently
highlighted is used in the simulation. For more detail on stream configurations see
the Stream Configuration section in LCSS (page 4-24).

The Stream tab also allows modification of the following characteristics of streams:
Stream Code

Alternate code used in other lamprey program documentation.
Simulate

The value of this flag is set to “true” (the checkbox is marked), i.e., the
stream selected here will be simulated. This field cannot be modified.

Treat

Specifies if the stream will be considered for treatment. If this flag is not
set to “true” by marking the checkbox, the treatments selected on the
Treatments tab will be ignored.
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Default Chem.Opt. Only

The default value of this flag is “true”, meaning that the streams will
always be treated with the options selected on the Treatments tab. This
field cannot be modified.

Latitude, Longitude, State/Province, and Country

Define the stream location.

Class
Is used in calculations of static basin-to-stream lamprey allocations (see
Lamprey Allocation section in LCSS, page4-40).

Budget Group

Is currently unused and should always be set to 1.

Stream Configuration

The Config tab allows entry and modification of stream configurations for the
currently selected stream. This screen is very similar to the Stream Configuration
screen in LCSS (see page 4-24).

A stream configuration is a definition of the physical layout of the stream. It 1s
composed of ‘"reaches", non-overlapping sections of the stream acting as
homogenous units. The reaches are connected by defining a downstream reach. The
lowest single reach in a group should be defined to flow into itself. A combination of
reaches, a stream configuration, represents the whole of the stream. A single reach
may belong to multiple stream configurations. A stream can have multiple alternate
stream configurations, although only one can be used in the course of a single
simulation.

All of the stream configurations for the selected stream are listed in the Srream
Configuration table of the Config tab.

The ID column in the table automatically generates unique identifiers for stream
configurations. The Description column provides short descriptions of each
configuration. New stream configurations can be added using the Add Conf
command button. Existing stream configurations can be removed using the Del Conf
button.

The Reach table lists all of the reaches defined for the stream for all of the stream’s
configurations. Reaches may overlap, although if they do they should not be
included in the same stream configuration. The Reach column uniquely identifies the
reach within the stream, ReachName provides a short description of the reach, the /n
column specifies if the reach is included in the currently selected reach configuration
(true = yes), and the DownStr column specifies which of the other reaches within the
current stream configuration is downstream of the selected reach.
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Activity

Expenses are reported in the fields Year, Amount and Description. Existing values
can be modified by clicking on a cell and simply overtyping the current contents.
Expense information can be added and deleted from the table using the Add and
Remove command buttons.

Values describing the cost of barrier planning, construction and maintenance are
displayed in the centre of the Barriers tab. These values can be modified by
overtyping currently displayed values with new ones. A choice of stream
configurations and barrier locations appears at the bottom of the screen in the Barrier
Location field.

The Activity tab contains a screen very similar to the Stream Barrier Activity screen
in LCSS (see page 4-30). Stream barrier activities define what happens in the stream
over the course of the simulation. Most notably, stream barrier activities affect the
allocation of spawners within a stream. Activities displayed in this tab apply only to
the currently simulated stream configuration.

«% Stream Parameters !ﬁ

,Streaml Ctmﬁg} BioF‘arml Bayriers 5" 1 Tfapsl SMHT‘ Spawnersl Treatments]
- Near . Stieam Barrier Activity [BanEffHyp}

11980 ' ; Description 17 SM Rate - 1SM Count|  ChemOpt
no barrier or barier not active 0 0/95
bartier active 10 01539

. {% Delaultfor the stieam configwation [Reach Set)

: Active Barriers:
 Yradd [47] LOW HEAD [JUMP POO

LLTRAP] -OLD WEIR SITE

¥rRemove

Yr Change

" Chem Opt Spawners l Act Add I Act Remave {

0K ’

All of the stream barrier activities for the current stream configuration are displayed
in the Stream Barrier Activity (BarrEffHyp) table. In the example above, two
different barrier activities are listed: "no barrier or barrier not active", and "barrier
active". Each barrier activity has an associated default Sterile Male Release Rate (SM
Rate) and Sterile Male Release Count (SM Count), and chemical options (ChemOpt).
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» To define a new stream barrier activity:

Note that at least one chemical option must exist before a stream barrier activity can
be defined.

1. From Edit|Stream Parameters, click on the Activity tab and click on the
Act Add command button.

2. Enter a Description of the new stream barrier activity (e.g. "barrier
active").

3. If this is the default activity for the stream, select the "Default for the
stream configuration" option.

4. If this is not the default activity for the stream, specify the year in which
this activity should take effect by pressing Yr Add. You need only
specify the year in which the activity changes. The barrier activity
remains the same until a new value is found or the simulation ends.

5. For each active barrier, check that the appropriate spawner allocation and
chemical treatment option have been defined for the activity by
examining the screens accessed by clicking on the Spawners and Chem
Opt buttons (see below).

» To remove a stream barrier activity:
1. Select the stream barrier activity you wish to remove.

2. Press Act Remove. All associated spawner allocation information will
also be deleted by this action.

The Activity tab can also be used to enter the default SM Rate and SM Count values.
SM Count refers to the number of sterile males released in the stream, and SM Rate is

the ratio of sterile males to non-sterile males released (see the SMRT section in
LCSS, page 4-51).

Once you have defined the stream barrier activity, you should examine the default
chemical treatment options associated with the barrier and the allocation of spawners
to the reaches of the stream. This information can be accessed by clicking on the
Chem Opt and Spawners buttons on this screen. Each is discussed below.

The Chem Opt command button activates a Chemical Option Details screen that is
identical to the one used in LCSS.
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i i, Chemical Option Details I

_ake; Superior - Bheam: - [107051 AMNICON RIVER

1 ChemOpti{Description
- 94

SysOntiinCig
True |True

default [no barier)
539 barrier - no treatment

. Window—— ‘ =
| Type: r'_'; St [0 M ‘ % Crew Size:
o . 05/31/00 10/3/00 | TreatmentLenghh:

~Chemical infonnéﬁux. Nor Target Risk:
L TRM: 72ioea  BaperGran [ Lo : '
| ,YFM . : . WP Non Target Cost:
arg: ] 0 aper W Q
1 10 Mitigation Risk:

’ f Prohabxﬁty of treatment failure: l Mitigation Cost:

add | | meachErt | selat |

This screen allows users to view and modify the chemical treatment option for the
currently selected lake and stream.

Each of the major fields on this screen is described below:
Lake/Stream
Identifies the current lake and stream.
ChemOpt
A unique 1dentifier that references the chemical treatment option.
Description

Provides a brief description of the chemical option.

SysOpt
Choose “True” if you wish to identify the associated chemical option as a
“system option” that will be protected from accidental modification.

In Cfg.
Indicates if the chemical option is relevant to the current stream
configuration (true or false). This value is used to select possible
chemical option alternatives when picking the best one to use for the
stream.

Window

Each treatment option is assigned a window type. A window is a time
period during which the treatment application occurs. Window types are
indicated as "P", preferred; "A", acceptable; or "N", not acceptable. The
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Window Type will be used by the automatic scheduler to select the
treatment windows for each stream.

Start Date

The start and end dates for the window types are entered as Julian dates.
The system automatically displays the standard month and day format
below this field. ‘

Crew Size
The crew size usually associated with this chemical treatment option.
Treatment Length

The number of days required by the selected crew to complete the
treatment.

Chemical Information

These fields display the types and amounts of chemicals used in the
chemical treatment option, and the probability of treatment failure.

NonTargetRisk
A value from 0 to 1 of the treatment risk on non-target species.
NonTargetCost

The probable cost incurred should the non-target species be affected by
the chemical treatment option.

MitigationRisk

The likelihood of having to prevent or minimize any non-target effects (0
to 1).

MitigationCost

The cost of carrying out any necessary mitigation measures.

The actions available from the Chemical Option Details screen are:
Add

Create a new chemical option. The system will allow you to use the
currently selected chemical option as a template for a new one. The new
option is entered at the bottom of the ChemOpt list. Modify the values in
each of the fields as necessary.

Delete
To delete a selected chemical option.

Select
Selects the current chemical option to be the new default option for the
Stream Barrier Activity screen or to be used as the current treatment on
the Treatments tab. This button has no affect on the Stream Info screen in
LCSS.
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ReachEff

Takes the user to the Treatment Effect on Reaches screen (see below).

The Treatment Effect on Reaches screen is accessed by pressing the Reach Eff button
at the bottom of the Chemical Options Details screen. It identifies the proportion of
ammocetes killed by the chemical treatment.

| . Treatment Effect on Reaches ]

Stieam Reaches: : ' : by Age: '
| 2BELOW NEW BAR.-OLD WEIR SITE ChemEH o
3ABOVE NEW BAR.-OLD WEIR SITE 036

QO] T3 (T o} QI S|

Don't Treat !

Portion Treated: [ ,  Set chemEff]

The fields and buttons available from the Treatment Effect on Reaches screen are:
Stream Reaches

Lists all reaches in the current stream configuration.
Portion Treated

Indicates the proportion of lamprey habitat affected by the treatment.
Efficiencies by Age

Treatment efficiencies for individual age classes. The usual settings are
.99 for high, .98 for medium and .95 for low efficiency.

Treat

Specifies that the reach is to be treated.
Don’t Treat

Removes a reach from treatment by the current chemical option.
Set ChemEff

Allows the user to enter a new chemical efficiency value for all age
classes. If you want to edit the chemical efficiency for a given age class
only, click on the ChemEff value that you want to edit and enter the new
value that reflects the portion of the age class killed.

The Spawner Allocation to Reaches screen in ISIS, which can be activated by
clicking on the Spawners command button on the Activity tab, is identical to the one
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=

in LCSS. Use this option to specify what proportion of the spawners entering the
stream should be allocated to each reach within the stream configuration.

| Spawner Allocation to Reaches 1

Lake:  [Superior ~ Sweam:  [[TO70STAMNICON AVER
;’Stream’Conﬁguratim‘: [Stream with barrier - ’
Stream Barier Activity. Jno barrier or barrier not active

| Proportion
[2]BELOW NEW BAR.-OLD WEIR SITE 0.3354
~ {[3]ABOVE NEW BAR.-OLD WEIR SITE 0.6646

Total Habitat Avea; 118601 -
Froportion s

This screen allocates spawners from streams to reaches. To allocate spawners from basins to
streams, go to the Lamprey Allocation option in LCSS (page 4-40).

As a general rule, the spawner allocation is set proportional to the habitat area in each
reach (as in the example screen above). This calculation can be done automatically
by clicking on the Proportion command button at the bottom of the screen. In some
cases, however, an operational barrier may block the passage of lamprey upstream
and the values in the Allocation to Reach column will be 1 (below the barrier) and 0
(above the barrier). The sum of allocation values for all reaches within a stream
configuration should equal 1, otherwise the system will be inconsistent in its
allocation by allowing more (or fewer) spawners to spawn than arrived in the stream.

The combination of the spawner allocation and the trapping mortality determines the
number of spawners arriving in the reach. More details on how these numbers are
used can be found in the model description in Appendix A.

Traps
You can simulate the placement of traps in reaches by using the Traps tab. The
screen allows users to define the placement, efficiency, and cost of both default and
non-default traps on the currently selected stream configuration.
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¥ Stream Parameters =10 X l

SStrBam Barrier Activity: ‘ no barrier or barri;-l not active ’ _:j
: "Défkauit Traps: - '
{Reach Desciiption . ArnOpCost | BanlD
[2ZBELOW NEW BAR.-OLD {ritest rap ’ ’ ) 2000

k Qverview  ECopy Add Remove I

. Noredefault Traps [YearTrapOn| YearT rapOff TrapEf AnnDpLost
. 1875 1980 0.5
1970 1980 ; 0.3 500

Add l - Bemove !

BK

ngD A default trap placement is specific to the stream barrier activity being simulated on the
stream to which the trap is added. For example, if the stream barrier activity for the
Amnicon River is set to “no barrier or barrier not active”, the trap is present whenever this
stream barrier activity is simulated.

[@ Whereas default traps are linked to stream barrier activity, non-default traps are defined for
a given year and are not dependent upon the stream barrier activity being simulated.

Fields and buttons for setting default traps with the Traps tab are:
Stream Barrier Activity

From the drop-down list, select one of the stream barrier activities
created for the current stream configuration.

Reach

Drop-down list of reaches available for placing traps.
Description

Enter a description of the trap.
TrapEff

Enter a value between 0 and 1 to represent the efficiency of the trap. A
value of 0.2, for example, specifies that 20% of all lamprey swimming
by this trap (to the reach on which the trap is located and all the reaches
above 1t) are caught.
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AnnOpCost
Enter the annual cost to operate the trap.

Barrier
Barrier (if there is one) with which the trap is associated. Choose from
the drop-down list provided.

Overview
Activates a summary screen which shows the cumulative effect of the
default and non-default traps (see Summary of Trap Activity in LCSS,
page 4-50).

Copy
Uses one of the “template” traps to create the new trap.

Add
Inserts a “blank” entry.

Remove

Removes the currently selected trap.

Fields and buttons for setting non-default traps with the Traps tab are:
YearTrapOn

First vear the trap is active.
YearTrapOff

First year the trap becomes inactive.
Reach

Specify the reach on which the non-default trap is placed.
TrapEff

Proportion of lamprey the trap catches in the reach where it is placed and
all the reaches above it.

AnnOpCost

Annual operating cost for the trap.
Add

Adds an entry to the Non-default Traps table.
Remove

Removes the currently selected entry from the Non-default Traps table.

Non-default trap placements act in addition to traps placed in the stream by default.
However, when a stream barrier activity changes (and with it the default trap
placements), all of the non-default placements are reset.
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SMRT

The Sterile Male Release Technique (SMRT) tab is used to set the non-default release
of sterile males to the currently selected stream. The default SMRT releases can be
set on the Activity tab (see the Default command button, below).

| 5% Stream Parameters ME B l

Ii Spawners | Treatrnent#]

'St;eéml Config | BioParms | Bartiers| Activiy | Traps | S
' Nondefaul Sterlle Male Releases:

. SimYvear SMCourt SMRBelRt Overview = |
2

1996] 3 . Defauk

Add

Fields and buttons on the SMRT tab are:

SimYear
The year of sterile male release.
SMCount
The actual number of sterile males released.
SMRelRt
The ratio of sterile to non-sterile males. For example, when the
SMRelRt in 1995 is 2, then 2 sterile males are released for every 1 non-
sterile male.
Overview
Activates a screen that provides a summary of the SMRT program.
Default
This command button switches you to the Activity tab to set default
SMRT allocations.
Add

Adds release entries for the currently selected stream.
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Spawners

Remove

Removes release entries for the currently selected stream.

The Spawners tab allows specification of the annual spawner allocation to the stream.

&% Stream Parameters

Skean] Conﬁgl BioParms] Baniétsl ﬁ.ctivityl Trapsi SMRT {_Spgg@ejg_il T:eatments‘l

SpawnerAbundance:

SimYear |Lake , - Stream | SpawnCountTotal | Sex
958 [ 10705 100
1965 10705 100 Sim. Stait Year:

5

1975]5 10705 78

19805 10705 100 (B
1990(5 10705 90 Sim. End Year
1550

{7 Betuin Spawners
Propn: Retun

’0.01 068248

Add

RBemove

__’J T able/Graph

This screen provides both numeric and graphic representation of spawner abundance.
The Spawner Abundance table allows entry and modification of the characteristics
(e.g. number and sex ratio) of spawners entering streams from basins, and is
independent of the transformer production in the selected stream (see also basin-to-
stream spawner allocation in LCSS, page 4-45).

To add a feedback, with stream transformers adding to the “basin” spawners, mark
the Return Spawners check box. ISIS will enter a value into the Propn. Return field
that identifies the proportion of transformers from the selected stream that return to
the same stream to spawn. This value comes from the basin-to-stream spawner
allocation calculation in LCSS (see page 4-45). The number of returning spawners is
calculated using the number of transformers produced 2 years prior to the current
simulation year (which allows for their residence in a lake), and incorporates the
appropriate basin mortality rate.

Although the Propn. Return value on the Spawners tab can be modified to simulate
various hypothetical situations, the original value cannot be recovered unless you
import a new stream.
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ISy

CAUTION: To avoid the possibility of conflicts, currently loaded stream-basin-stream
allocation data are deleted prior to loading a new set of values. This may cause some
streams to behave differently following the loading of an unrelated stream (due to different

survival rates of parasitic phase lamprey and different proportions of returning spawners).

The system does not require all of the years of the simulation to be entered. The
spawner levels are kept constant based on the last known value (eg. if the number of
spawners is set to 100 for 1965 and then to 78 for 1975, the number simulated from
1965 to 1974 will be 100 and from 1975 on will be 78). If there are no values
entered for the spawner numbers prior to the currently simulated year, the lake
default is used.

The yearly records can be added or removed using the Add and Remove command
buttons.

The size of the spawner run can be reviewed graphically by clicking on the
Table/Graph command button.

&% Stream Parameters M=l !
Stream] Conﬁg' EBQPatmsi Baniersl Aciivity} T:aps’ SMRT l T;eatmenlsl

“ Spawner Abundance:
o : Graph LLBound:

‘ ‘ L ! Sim. Stat'Year
11958
Sim. EndYear
1390

¥ Relumn Spawners
Propn. Return

0.01068248

Table/Graph

In the graph of spawner abundance, the horizontal x-axis ranges from the year
entered for Sim. Start Year to the year entered for Sim. End Year. These values
represent the start and end years for the simulation. The vertical y-axis depicts
spawner abundance. The y-axis maximum is set to the value in the Graph U.Bound
field. If no value is entered by the user in the Graph U. Bound field, the system will
use the largest value found among the data displayed as a default upper bound for the
y-axis. The y-axis minimum is set to 0.
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Only the data for the basin-to-stream spawners (ie., data entered i the table) are
displayed on the graph since the value for the returning spawners is dynamic and
unknown prior to the simulation.

Treatments

The Treatments tab is used to view and modify chemical options for the currently
selected stream. Access to this tab will be denied if the Treat flag on the Stream tab
is not set to “true” (see page 5-6).

&4 Stream Parameters I ]

St:eam! Conﬁgl BioPaxmsl Barriersl Activity] Trapsl Sis-!RTi Spawners

- SimYear 'Ehemﬂpt

1962
1967
1871
1972
1975
1978
1980
1984
1988
1991
1934

Treatments for particular simulation years can be added and removed using the Add
and Remove command buttons. Users can view and modify chemical option values
by activating the Chemical Option Details screen (Chem Opt command button) (see
page 5-12).

Model Menu

The Model Menu contains two options.

Bun
View Besults

The Run option executes the model for the currently selected stream.

The View Results option allows you to view results of any of the saved runs.
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RuUN
The lamprey model can be run for the specified range of years. Each instance of the
run is stored under a separate heading. The Simulate Stream screen can also be
activated from the button bar using the Fj;
. Simulate Stream
tatYear 1358 EndYear lTSSU
Wi New Run I Br!]
~ Run Desciiption for [510705] |
. {TestRun|
gK ‘ Cancel
The model simulates all of the aspects of the stream including the barriers, SMRT,
and Traps.
VIEW RESULTS

The last of the major components of ISIS can also be accessed from the Model
Menu. It allows review of the results of runs stored in the database.

Here you can compare results of simulations of streams with one another or with
assessment data (if available). The Run Results Setup screen can also be activated
from the button bar using the {41} icon.
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© Bun Results Setup M=l B3 !

Fiun Data Sets [select one or more):

0 0] ANCASTER CR.1958-1990 sdf
S 10705] AMNICON RIVER 19581930 11/27/96 2:43:00 PM
[S 10705] AMNICON RIVER  1958-1330 sdf

| @ SideBySide INIx

s

;{{Qisplay Tupe

,Sxaphs {select one or more): :

Stream Transformer Production
Unweighted) Ammocete Density Dep
Spawn Bun Size

The lists, options, and buttons on the Run Results Setup screen are:
Run Data Sets

Lists all of the runs available in the database. One or more runs can be
selected for graphical display.

Display Type
Allows you to display the results either side-by-side or as overlayed
graphs.

Graphs
Lists all of the parameters available for graphing (select one or more).
Each of the parameters selected will be displayed for each of the data
sets selected.

View Graphs
Displays or refreshes the graph display (see below).
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¢+ Run Results View

Streamn Transformer Production [S 10705] Spawn Run Size [S 10706} 11/27/86 2:48:00 PM
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Help Menu

Help is available in two ways: through the Main Menu and from each screen. The
help provided through the Main Menu is indexed for easy reference and can be best
used for getting an overall view of the system and for finding out about specifics of
the program's operation.

The help available from the screens is context-sensitive and is related directly to the
options available from the screen. This type of help can be invoked using the <F1>
key while using the system.

The information presented through both options is identical. The index presents a
top-down view of the system, beginning with general topics and moving to more
detailed information about ISIS. The context-sensitive help goes directly to the
section of the Help Menu most applicable to the current screen.

The help files follow the standard Microsoft Windows Help format.
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6.0 Appendices

Appendix A: Sea Lamprey Model

OVERVIEW OF MODEL

The lamprey simulation model of the IMSL DSS describes both the lake and the
stream phase of the life history of sea lamprey. The spatial structure of streams,
reaches and lamprey basins is described in Section 2.0 of this manual. The stream
reach model describes the production of ammocetes and transformers, and the effects
of control options on stream phase lamprey. The lake phase model accounts for the
survival and allocation of parasitic phase lamprey in the lamprey basins. The model
describes the following components of lamprey dynamics:

Stream Phase:

1)

2)
3)

4)
5)
6)
7
8)

allocation of spawners among stream reaches and the effects of barriers on the
allocation;

effects of traps on the size of spawning populations;

lamprey fecundity and the effects of sterile male release on spawning recruitment
to age O+;

ammocete migration to downstream and lentic reaches;
survival from egg to age 0+,0+ to 1+, ...9+ to 10+ ammocetes;
growth of ammocetes;

transformer production; and

mortality due to chemical control treatments.

Lake Phase:

1)
2)
3)
4)

allocation/movement of transformers (adults) to lamprey basins';
sex ratio of adult lamprey;
survival from transformer to adult parasitic phase; and

allocation of spawners from basins to streams.

1

The term lamprey basin is used here to refer to the area over which a population of adult lamprey is distributed. This spatial unit

may or may not correspond to geomorphic lake basins. In practice, the lake basins relevant to the spatial dynamics represented in
LCSS likely correspond to the geographic range of primary prey populations.
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The parameterization of these life stages in the model is based on assessment data,
and on parameters in the prototype Lake Ontario lamprey model (see Greig et al.
1992 for review). Density-dependent hypotheses of ammocete survival, growth and
transformation rates are described by the model. LCSS users can change the
parameters of all model functions to simulate density-dependence and control the
strength of each hypothesis.

INTERACTION OF MODEL WITH LCSS INTERFACE

The Lamprey Control Selection System (LCSS) allows the user to apply control
options to lamprey populations that are simulated by the model that is linked to it.
Users input data into the LCSS (such as treatment characteristics, population
parameters, stream habitat data) that describe the dynamics of lamprey populations.
The model then uses this data to simulate the annual population dynamics of lamprey
in all reaches within the IMSL database. These simulations can be compared to
available assessment data to further refine the input parameters. These simulations
can be compared to available assessment data to further refine the input parameters.
LCSS also allows for the interactive selection of controls (TFM/Bayer treatments,
traps and barriers) year to year, or automatically (for TFM/Bayer treatments) for
long-term runs. An overview of the sequence of calculations within the LCSS
lamprey model and the model's dynamic interaction with the treatment scheduler are
itlustrated in Figure A.1.

LCSS saves the simulated, annual population structure (ammocete density by reach
and age) of both treated and untreated streams/reaches in the database. Users can
view the results of LCSS simulations in either graphical or tabular report in MS
Access.

STREAM INVENTORY AND SIZE OF LARVAL HABITAT

Streams are composed of reaches of larval lamprey habitat as described in Section 2
of this manual. Reaches have been established for portions of streams that have been
treated as discrete units at some time in their history. These reaches inclhude
significant stream tributaries and sections. Lamprey barriers also separate reaches
within streams. Some river systems where large tributaries are always treated as
single discrete units are represented as separate streams to simplify the reports and
summaries (e.g. Oswego River System - Lake Ontario and the Cheboygan River
System - Lake Huron).

The estimates of the quantity and quality of available habitat in each reach are used to
establish the effective amount of Type I or optimal larval habitat. The total area of
each reach is defined by its length and width. Reach length is defined as the average
length of stream populated by ammocetes. In some streams, habitat length has been
measured directly during random transect surveys. For other streams, the average
length of the treated reach is used as a surrogate for habitat length. Likewise, reach
width has been measured directly for some streams, while in other cases, stream
widths have been estimated from a relationship between width and discharge
(Leopole and Maddock 1953) and parameterized with available data:

Width = 9.82 x Discharge °*
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Figure A.1: LCSS interactions with the IMSL lamprey and fish community
models.
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Average treatment discharge is used as a surrogate for mean annual discharge where
estimates of mean annual discharge are not available. Total area of the reach is
estimated as the product of length and width.

TotArea = AvgReachLen x ReachWidth

The total reach area is adjusted for the quality of larval lamprey nursery habitat
available. The proportions of Type I (i.e. optimal, PHQual) and Type II (i.e.
acceptable PMQual) habitats have been measured for some streams during random
transect surveys. The average values for these habitat proportions have been applied
to reaches where these detailed surveys were not available. The U.S. Agents have
separated Type I and II habitats and density estimates in their random transect
surveys. There is a significant difference in the average density of ammocetes
between these habitat types. The average ratio of Type Il to Type I densities (Type I
= (.2 Type I) has been used as a weighting factor to adjust the Totdrea to an
estimate of effective Type I or optimal habitat.

HabArea = TotArea x PHQual + TotArea x PMQual x 0.2

The Canadian agents have not separated Type I and Type II habitats in their
quantitative estimates. The average habitat quality proportions found in the U.S.
surveys have been applied to the Canadian streams.

The estimates of habitat quality used were for whole streams, and were applied to all
of the reaches within the stream (habitat quality estimates are available by reach and
should be used to refine these values). The areas for lentic reaches are estimated
from historic treatment and assessment data. Where available, survey and treatment
data have been used to estimate the effective optimal habitat area within the lentic
reach.

Spawning habitat is not explicitly defined as a model parameter. Lack of spawning
habitat in lentic reaches or in some reaches below barriers is modelled by reducing
the egg survival rate to zero (EggSurvRt = 0).

LAMPREY BASIN DEFINITIONS

Lamprey basins have been assigned on the basis of current understanding of
parasitic- phase population patterns. Alternative basins can be selected for running
historic or future simulations with the LCSS. The default basin for all the lakes is the
whole lake. A total of 11 lamprey basins have been defined for the system including
4 in Lake Superior, 3 in Lake Huron, 2 in Lake Michigan, 1 each in Lakes Erie and
Ontario. Streams are assigned to each basin on the basis of the proportional
allocation from basin to each stream (PropToStream). In the current version,
spawning phase lamprey are allocated to individual streams from only one basin.
Likewise, the current version allocates transformers from one stream to only one
basin.

SPATIAL DYNAMICS: MOVING SPAWNERS TO REACHES, TRANSFORMERS TO SALMONID STOCKS

It is important to understand the movement of lamprey populations from natal
(origin) streams to lamprey basins (lake arecas inhabited by salmonid stocks) and
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subsequently to spawning (destination) streams before using the LCSS. The system
has been designed to allow flexibility when partitioning the effects of lamprey
populations in lakes and allocation back to streams.

Figure A.2 illustrates a conceptual model for thinking about lamprey movement. Part
A represents movement of transformers from origin streams to lamprey basins and of
spawning-phase lamprey from basins to destination streams. The arrows in the figure
should be thought of as representing not just the basins where transformers end up
but also the proportion of transformers leaving each stream which will inhabit each
basin. Some origin streams may produce transformers that will impact the salmonids
in one basin only (e.g. streams 1 and n in Figure A.2_A) while others may impact
more than one basin (stream 2, Figure A2_A).

Oign Parasiic Prese Destindion
Streams Basins

Lamprey Basin Destingtion Stream

ABCDS=s - 1 Qe nes X yoeer

.

N
4
]

TUOw >

- 1
Rue based
cellvaues

Crign Stream
|
Larrprey Basin

Figure A.2: Conceptual model for representing the spatial movements of
transforming ammocete and spawning adults between streams and lake
lamprey basins.

Spawners from any one basin are likely to enter any one of several destination
streams, and some streams may attract spawners from more than one basin. The St.
Mary's River is a good example of a stream which may impact on and receive
spawners from multiple basins. The lamprey population in any stream that lies near
the boundary between two distinct (or nearly distinct) basins may also interact with
more than one basin. The arrows in the figure illustrate the linkages from origin
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streams to basins and from basins to destination streams. Reading across each row,
the actual entries in the matrices are the proportion of lamprey moving from the
origin stream to each basin (left matrix) or from a basin to destination stream (right
matrix). The sum of all entries across each row must be equal to one.

This structure was designed to offer full flexibility in allocating lamprey populations
and in assessing the effects of this spatial allocation on targets and control selection.
However, the structure is limited in that the allocation of spawners is fixed for all
years of the simulation and cannot respond to annual larval population abundance or
to stream treatments as determinants of recruitment.

SIMULATING THE CHARACTERISTICS OF THE SPAWNING POPULATION WITHIN REACHES

Determination of characteristics of the spawning population within reaches is
composed of two basic steps:

« determining spawner allocations to streams and to reaches within streams
(including, where applicable, the effects of the barriers and traps); and

» determining the size of the individual spawning lamprey.

Lamprey Basin to Destination Stream Allocations

The number of spawners from a given basin allocated to an individual stream is
defined by the parameter PropToStream for the selected lamprey basin structure.
This proportion is calculated outside the current system based on the rank of the
stream as a primary, secondary, or non-recruiting (dormant) spawning stream and the
stream discharge. Primary streams receive 90% of the spawning run, secondary
streams get 9.5%, and the remaining dormant streams get 0.5% of the total spawning
allocation. Within each class, the allocation is based on the proportion of total
discharge from an individual stream. Average treatment discharges have been used
as a surrogate for spring or annual discharge values. The PropToStream for any
individual or group of streams can be manipulated through the LCSS with the system
normalizing the remaining values so that the total allocation is equal to one. The
PropToStream selected affects all years of simulation for that scenario.

The resulting number of spawners allocated to a given stream is:

SpawnCountTotaly, = Z altbasins PropToStreamy,g, x SpawnCountpgg,

Basic Rule for Allocating Spawners to Reaches

Most lamprey streams in the Great Lakes basin only have one lamprey-producing
area that is treated on a regular basis. Some streams, however, have more than one
discrete lamprey-producing area. Discrete lamprey-producing areas can be reaches
along tributaries of streams, complete tributaries, or lentic areas. These production
areas of streams considered by the LCSS model, and therefore subject to independent
treatment simulation/scheduling, are referred to as reaches. For those streams that
have discrete lamprey-producing reaches, each reach will receive a portion
(SpawnCounty, .,) of the total number of spawners (SpawnCountTotaly,) that are
allocated to the stream according to a reach-specific proportionality constant
(SpawnAllocEtrg, ..). It is assumed that the reach receiving spawners will support the
recruited ammocetes.
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SpawnCounty, ea = SpawnAllocKtr sy rea X SpawnCountTotaly,

The proportionality constant is determined empirically, and is stored in the database
record for the reach. User-specified criteria such as streamflow, habitat area, habitat
quality, or judgement (observed ammocetes) will determine the proportionality
constant. The default values of SpawnAllocFtrsy ., in the current system are based on
the proportion of total areas in each reach to the total stream. Unlike spawner
allocation to streams, the allocation to individual reaches can be varied by year to
simulate the effect of barriers.

Effect of Barriers and Allocation of Spawners to Reaches

The activity of barriers modifies the allocation of spawners to reaches. Each state of a
barrier (e.g. active, inactive, leaky) or distinct combination of these states for
multiple barriers (e.g. for two barriers, both active or the first active and the second
inactive, etc.) dictates a new allocation of spawners to reaches. These are stored
separately in the database and used instead of the default allocation (all barriers
inactive). The SpawnAllocFtry, ., for reaches above active effective barriers is 0. The
spawners in the stream are reallocated to the reach(s) below the barrier. Existing
barriers that do not work use the default SpawnAllocF¥y, ., for that stream.

Effect of Traps on Size of Spawning Populations

While barriers redirect spawners, the traps actively remove part of the spawner run.
Individual traps are placed on reaches, thus affecting all of the spawners going to
reaches upstream of the trap as well as the spawners of that particular reach.

The effect of traps on each reach, TrapEff s, rea, is calculated by combining the effect
of all traps downstream of that reach.

TrapEff;t,,,ea = 1 - Hdownstream,rea (1 - TraPEﬁwap)

The effect of trapping on the number of returning spawners to a reach
(SpawnCounty,,..) is described by:

SpawnCountyy,rea = (1 - TrapEffy,rea) % NewSpawnAllocy, yea x SpawnCountTotaly,

Size of Spawning Lamprey

The size of the spawning lamprey affects recruitment through fecundity. In the
absence of a dynamic fish and parasitic-phase feeding model, this model assumes
uniform growth of adult lamprey to an end-of-feeding season mean weight
(PreSpawnWeightiamprey sasiny of 0.2 kg. The end-of-feeding season weight in the
lamprey model is lamprey basin specific and can be adjusted to reflect differences
among the basin populations. This weight is then reduced by 15 percent
(PreSpawnWLosS amprey basin) PriOr to spawning to produce the lamprey spawning
weight (SpawnWeightiumprey basin). ~ The length of spawning female lamprey
(SpawnLenFemumprey vasin) 15 predicted from SpawnWeight amprey basin-
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SpawnWeight ampreppasin = PreSpawnWeightiampreppasin % (1 - PreSpawnWLoss ampreybasin)

LenWeightExp

SpawnLenFemiampreypasin = (SpawnWeightiampreypasin X LenWeightMult)
where:

LenWeightMult = 2.47E7 and
LenWeightExp = 0.397

SpawnWeight, SexRatioFem, SpawnLenFem, and EggsFem, are all calculated for
each basm. If multiple basins contribute lamprey to a single stream, they are
combined using weighted averages. All are calculated in this manner because the
relationship between weight and length is non-linear, so calculating length after
combining the weights would produce a different result.

ESTIMATING AMMOCETE RECRUITMENT TO AGE 0+

Sex Ratio

Simulating the recruitment of lamprey to the stream population within a reach
involves four basic calculations:

» determining, from the population sex ratio, the number of male and female
spawners;

* determining, from estimates of lamprey fecundity, the expected egg deposition
by a single spawning female;

+ estimating the number of successful spawns as modified by a user-specified
scenario of sterile male release (SMRT); and

+ determining, from the expected survival rate of eggs to age 0+, the number of age
0+ ammocetes recruited to the reach ammocete population.

The sex ratio of spawning phase lamprey from a given basin is determined by the
sex ratio of the transformers contributing to the population. The sex ratio of spawning
lamprey in an individual stream is equal to that of the entire lamprey basin (i.e. not
variable over the individual streams within a lamprey basin. The LCSS uses the
coefficient SexRatioFemy, to determine the number of female spawners within each
reach to which spawners are allocated.

SpawnCountFemgy, roa = SpawnCountsy, ., x SexRatioFemy,

Effects of Sterile Male Release

Two numbers specify the SMRT release: SMCount and SMRelRt (release rate).
SMRelR¢ is the ratio of sterile to normal males in the stream. The number of
successful spawnings are reduced in direct proportion to this ratio. SMCount is the
number of sterile males released in the stream. SMRelRT is calculated for SMCount
and the predicted number of normal males in the stream. If both numbers are present,
SMRelRt takes precedence. If neither is specified, a default value associated with
each spawner allocation criteria set (SpawnAllocFtry ,..) is used.
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Fecundity

Age 0+ Density

Placement of sterile males either as a fixed number or defined ratio (SMCount ,, or
SMRelRt ) in a stream will reduce the number of successful spawners. The number
of successful spawning females of a stream into which sterile males are released
(SuSpawnFem s, .q) 1s calculated by:

SpawnCountFemst, rea
(1 + SMRelRt str)

SuSpawnFemgy, rea =

If there are no sterile males released into a reach (SMRelRtstr = 0) then

SuSpawnFemgy, rea = SpawnCountFemsy, req

Please note that the sterile males are kept as a rate which does not change if traps are
present. In effect, this simulates SMRT release to the mouth of the river during
spawning runs and assumes that sterile males are affected by the traps in the same
way as the rest of the lamprey.

Fecundity is determined with the relationship between SpawnLenFem,, (mm) and
egg production in the prototype Lake Ontario simulation model. This preserves the
ability to simulate potential lake environment or prey species effects on ammocete
recruitment. The total number of eggs allocated to a reach (EggsDenuy, r.q) is equal to
fecundity times the number of females allocated to the reach (SpawnCountFemy, rea).
As with population size in reaches, eggs are tracked as density.

EggsFem = FecunRegCoef x SpawnLenFeMampreprasin + FecunReglnter
where:

FecunRegCoef = 205.6
FecunReglnter = 12017

|

EggsFem x SuSpawnlem s, rea
HabArea

EggsDeng, rea =

Please note that EggsFem is calculated on a basin-by-basin basis and is then
combined as a weighted average to give stream values.

Ammocete recruitment from egg to age 0+ is calculated by multiplying the total
number of eggs produced in a reach by an empiric survival rate:

AmmDeng, roa 0 = EggSurvRates, .a X EggsDensy e
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GROWTH AND SURVIVAL OF AMMOCETES

Ammocetes can be moved downstream between reaches in order to simulate
processes populating lower reaches and lentic areas. Ammocetes migrate only to a
reach below the current one. The number of migrating ammocetes is calculated
before mortality or transformation has been applied. Migration can be defined for all
age classes, but does not affect the young of the year (YOY). The average population
length at age for a reach does not change within migration; only the number (density)
is altered.

The additional recruitment resulting from migration is considered in all of the
density-dependent functions for survival, growth and transformation and sex ratio.
Chemical options affect migrated ammocetes as they would the resident population.

In the base system, the rate of downstream migration by age has been to 0 for all
reaches except those above lentic reaches. The rate of migration to lentic reaches is
0.1 for all ages.

Ammocete Density

AmmDenTotalgy e, = Z,,ge (AmmDengy, eq 00 +

Ammocete Length

Ammocete abundance at age in a reach is accounted for as density, that is, the
number of ammocetes at age divided by the area of habitat of the reach suitable for
ammocetes (HabAreay, ..). Total density (AmmDenTotaly, ,.,) is the sum across ages,
but does not include the current year's age 0. The effects of ammocete migration are
included in this sum.

HabAreag, ;o = HabLengy, o, x HabWidthgy, re,

AmligTOut str, rea, age = Amligﬂn str, rea, age )
HabArea str, rea

The growth of ammocoetes is modelled independently for all reaches and is
dependent on density in that reach. The pattern of length at age is predicted to
follow the von Bertalanffy growth model. The general form of the von Bertalanffy
growth equation is:

-Kstr,
AmmLenstr,rea,age = LQO X (l_e Lea X agc)

where:
L, = theoretical maximum asympototic length of ammocoetes
(default = 200 mm), and
K = the Brody growth coefficient.

Figure A.3 presents the relationship between length and age for different values of K
following the growth model. K has been estimated for individual streams based on
the length at age 2 + (Figure A.4). Average values for size at age 2 have been used
where data were not immediately available.
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Von Bertalanffy Growth Curve
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Figure A.3: Simulated ammocete growth in length for minimum and maximum
observed values of K and L., = 200mm.
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Figure A.4: Relationship between mean length at age 2 and K.

The rate of growth determines the age of first transformation by determining the age
at which the size threshold is met. The size threshold for metamorphosis is estimated
to be 120mm. The age at which a year class begins transformation is the age at
which its mean length is equal to 120mm.  This threshold parameter
(AvgLenlstTrans) can be modified to better represent the distribution of size within a
yearclass as data becomes available. Figure A5 relates the age of first
transformation to the value of K. The growth of an individual age class will be
determined by its growth history, that is, the rate of growth (K) in each year of life.
The value of K is dependent on density.
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Figure A.S: Relationship between age of first transformation (mean length = 120
mm) and K.

The density-dependence in growth is modelled using a 2-point SLP function with the
Brody growth coefficient K being dependent on total ammocete density,
AmmDenTotal (see the end of this section for discussion). The two points used are
(AmmDenl, AmmK1) and (AmmDen2, AmmK2). The variable AmmLen, yeq age , holds
the average size of an ammocete age class at the end of a growing season. Therefore,
the size for age 0 is calculated by:

AmmLens, ronage = Lo x (1 -5 1)

Older ages are subject to varying densities, and therefore varying values of the Brody
growth coefficient. Ammocete length is calculated incrementally by:

AmmLeny, ronae = AMMLENy roanrer + Lo x €57%9 x (1 -¢°
,rea,ag \rea,ag

where:
AmmLeng, oq 401 15 the length at the beginning of a given season;

AmmLeny, req qge 1s the length at the end of a given season.

The following equations are derivations for the annual ammocete length increment:

Lw (1 -e -k (age + 1)) —Lw(l -e —kage)
:Lw ((1 _e -k (age + 1)) . (1 -e -kage))
— Lm (e -kage _ e -k(ageﬂ))
:Lao (e -k age _ e -k (e —kage))

=Lo,e % (1-¢™)
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Ammocete survival

Ammocete survival for ages 0+, 1+, ..., 9+ to the next age class in a reach at low total
ammocete density is estimated by multiplying an empiric annual survival rates
(AmmSurvyy, reqage) by the ammocete year class strength (AmmDenyy, eq46.). The
density-dependent survival rate, AmmSurvsy, . , is calculated using 2 point SLP
functions with the survival rate dependent on total ammocete density. Points used are
(AmmSurvDenl, AmmSurvRt]) and (AmmSurvDen2, AmmSurvRt2).

AmmMi j Y In str, rea = AmmM lgI’Out str, rea
HabArea str, rea

AmmDenstr,rea,age = Ammsurvstr,rea,age XAmmDenstr,rea,age»] +

The final age class, 10+, is assumed never to transform and is dropped from the
calculations.

SIMULATING THE EFFECTS OF CHEMICAL TREATMENTS

The effectiveness of TFM and Bayer is reach and age specific. The surviving number
of ammocetes in each age class following chemical treatment (AmmDens, reqage) 1
calculated by multiplying the current number of ammocetes in each age class by
effectiveness factors for TFM, or TFM and Bayer (ChemEffy,req,qg.) and the portion
of the reach treated (ChemTreatParty,,.,). Application time (spring vs fall) will
determine treatment effectiveness for 0+ ammocetes. The effectiveness factors can be
defined by treatment windows to account for this seasonal variation. Treatment
effectiveness has been estimated by treatment personnel as High (99%), Medium
(98%) or Low (95%) for each chemical option for each treatable reach. In the current
model, the same effectiveness values are applied to all ages (including age 0) and to
all windows for a given reach.

AmmDenKillyy, roqage = ChemTreatPartsyea X ChemEffsyreaage % AmmDeny, req age

AmmDenyy, yegage = AmmDeNgy reqage - AmmDenKilly, req age

where:

AmmDenKilly, req 00 = kill density by age.

The density for reaches of which only a part was treated is assumed to become
uniform before the next year.

SIMULATING TRANSFORMATION TO THE PARASITIC PHASE

The model uses a four stage transformation model with the user-determined yearly
transformation rates, TransRl g, (e.g. 10%, 33%, 66%, 100%). Each transformation
rate applies to the remaining population size (AmmDen,,  oqge) for a specific age
class, as is shown in Figure A.6 below. Transformer production is accumulated
across all of the transforming age classes:

TransDengy reqage = TransRisge x AmmDeRy, req age
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Sex Ratio

TransPrody, e = Zag@ TransDengy, reqage X HabAreagy, req

As described above, the transformation is triggered by a global parameter,
AvglenlstTrans, average length at first transformation. All of the transformers are
considered to be the same basin-specific size, PreSpawnWeightyasin.

. /
0.4 /
/

0 T T T
0 1 2 3 4

Year of Transformation

0.2

Cumulative Proportion of Year Class

Figure A.6:  Cumulative proportion of a year class transforming where year 1 =
age of first transformation and the yearly transformation rates are 10%,
33%, 66%, 100%.

Transformer sex ratio is dependent on total density, AmmDenTotal, and is modelled
using a 2 point SLP function with the proportion of females dependent on density.
The two points used are (SexFemDenl, SexFeml) and (SexFemDen2, SexFem2). In
the current model, the SexFem/ and SexFemZ2 values are equal and set to the current
basin average sex ratios.

Allocation to basins

Each stream contributes transformers to one or more basins. The total number of
transformers entering a basin is calculated by:

TransCountpag, = Zstn,ea TransProdsyrea x PropToBasilg, pasin

Transformer sex ratio for a basin, TransSexRatioFemy,,, is calculated using a
weighted average.

SIMULATING ADULT (PARASITIC PHASE) INTERACTIONS

The transformers leaving the reaches, which now become "origin" streams, to
become a part of the adult parasitic population that preys on the salmonid stock.
Transformer survival to the parasitic phase, PPLampMorty.g,, 1s constant for the
basin, and the sex ratio, PPSexRatioFemy,g,, does not change:
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PPCountyusin = PPLampMortyasn X TransCountygin

PPSexRatioFempug, = TransSexRatioFempagn
In the current model, PPLampMortbasin = 0.5.

DENsITY DEPENDENCE AND SLP FUNCTION

As mentioned earlier, many of the ammocete characteristics are density dependent.
The magnitude of density dependence is determined using a 2 point SLP function.
The two points used in this example are (dmmDenLow, AmmValLow), and
(AmmDenHigh, AmmValHigh). At density below the lower threshold (AmmDenLow)
the density dependent value is equal to AmmValLow. Between the two threshold
densities the value is interpolated. Above the upper threshold (4mmDenHigh) the
density-dependent value again becomes constant at AmmDenHigh. Even though
LCSS uses a 2 point SLP function, in general the SLP functions can contain any
number of points.  —

Figure A.7 shows the general form of the hypothesis function used to determine
ammocete dynamic rates versus total ammocete density. Form 1 shows the effect of
upper and lower density thresholds. Form 2 shows a constant rate where the low and
high values are equal.

1.0 4
form 2

form 1

0.5 - Q
Q1
T T T
10 20 30
Total ammocete density (#/m?)

Figure A.7: General form of the hypothesis function to determine ammocete
dynamic rates versus total ammocete density.

The density thresholds for all of the SLP functions have been initially set to the same
values. The first threshold is set to equal the geometric mean density plus 2 standard
deviations (10/m?) as estimated from Lake Superior quantitative assessment results.
The second threshold is at 3 standard deviations above the geometric mean (20/m?).
The effect of these thresholds is to set most rates constant under the current regime of
treatments and densities. The lower values for all of the rates have been arbitrarily set
to one half of the current rate estimate.
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Appendix B: Database Structure

OVERVIEW OF THE DATABASE STRUCTURE

The review of existing structures was guided by the objective of identifying
opportunities for improving consistency and/or simplification of the database. In
many respects, the objective of simplifying the database structures arose not from
specific technical design concerns but rather from the early difficulties which LCSS
users were experiencing in working with some of the concepts employed within the
design. In particular, three areas were targeted as foci for review:

1) the concept of stream configuration (i.e. alternative definitions of the
physical structure, i.e. sets of reaches, of an individual stream);

2) stream barrier activity (closely related to stream configuration); and
3) lamprey basins.

Each of these three components of the database design deal with the representation of
spatial structures within the IMSL/LCSS database. They are central to the overall
utility of the system and their implementation is moderately to highly complex with
regard to the relationships between database tables.

Additionally, the database structures related to budget groups and reporting basins
were of special concern. These features are only partially implemented in the current
system and there are outstanding issues related to their definition and utility within
the overall system.

Stream Configuration

The primary focus of the review of the implementation of reach sets was to determine
whether the structure of the database could be re-engineered so as to dispense with
the concept and terminology of ‘stream configuration’ or whether an alternative
implementation could buffer general users of the system from having to work with
the stream configuration concept. A clear understanding of the concept and rationale
for our recommendations requires at least an overview of the current implementation
of the stream configuration concept.

The basic function of the stream configuration concept within the IMSL/LCSS
database is to provide a mechanism for representing scenarios which would explore
proposed (theoretical) barrier dam placements for lamprey control. When barriers are
placed on a stream, their intended purpose is to restrict access to spawning and
potential rearing habitat. Barrier placement therefore potentially influences the
number of reaches in which it is necessary to simulate lamprey populations within the
stream (multi-reach streams only), habitat characteristics of the ‘reach’ where the
barrier is placed, and the selection/definition of chemical, trap and SMRT options for
treatment of any residual lamprey populations. The related concept of stream barrier
activity deals with the efficiency of a barrier in blocking upstream passage of
lamprey.

The interdependence of the various tables in the database can best be described by
presenting the modifications involved in adding a stream configuration to the present

Integrated Management of Sea Lamprey Decision Support Tools Appendices ¢ 6-17



LCSS: User Guide

database structure. Some of the tasks presented here can be accomplished using
LCSS, but the changes have been described for the sake of completeness.

Reaches represent distinct areas of ammocete habitat to be simulated. These may or
may not represent the configuration of ammocete habitat found in a stream. In most
cases it is not necessary to simulate all of the distinct areas of ammocete habitat
separately. If a stream is always referred to as a single unit, all of the areas can be
dealt with together. It is important to distinguish between areas if a density of
ammocetes in one area will change differently than in others, due to some external
factors (such as a barrier, treatments which sometimes treat only a part of the stream,
etc.).

Stream configurations are sets of reaches which taken together represent the whole
stream. There can only be one stream configuration per stream for any given
simulation run although its behaviour may change (see Stream Barrier Activity).
Alternative stream configurations are used to represent different configurations of a
stream {e.g. with presence of a barrier simulated or with no barrier throughout the
simulation).

Adding stream configurations is necessary if a new representation of a stream is
required (eg. a new barrier is planned). Let's suppose we would like to add a barrier
to an existing simple one-reach stream. Suppose that the new barrier will split the
reach in two. (If it did not we could easily utilize the existing reach structure.)

The first step in adding a barrier is to add a new entry into the ReachSet table. This
step automatically generates a new ReachSetID value. This value will be used
throughout the database to refer to the new stream configuration.

Next we will add new reach definitions in the Reach table. It is up to us to select
values for the Reach field. These cannot conflict with other values of Reach field for
the same Lake and Stream. In our example, assuming that the original reach value
was 1, the new values could be reaches 2 and 3. Reach 2 represents the area below
the barrier and reach 3 represents the area above the barrier. Most of the attributes of
the new reaches are the same as for reach 1. The main difference is the habitat area
(Habitat Area), which is now split into two. A description of how to initialize the
population structure in each of the reaches can be found later in the Results Database
section.

One situation that may arise when adding a barrier is that the barrier will block
lampreys' access to all of the spawning habitat. This situation can be handled in one
of the following ways:

1) Do not allocate any lamprey to any of the reaches (SpawnAllocFtr set to
0). This will simulate lamprey staying at the mouth of the river and not
swimming up the stream. In this approach the barrier trap, if present, will
not catch any lamprey.

2) Create a "dummy" reach below the barrier and set the egg survival rate
(EggSurvRt in ModelReachParms) to 0. This will simulate lamprey
swimming to the barrier, spawning at the site with no eggs surviving.
This approach will allow the barrier trap to catch lamprey swimming to
the barrier. When the barrier is not active, the allocation to the dummy
reach should be set to 0.
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The new reaches should also be added to the ModelReachParms and
ModelReachAgeParms tables. The entries will most likely be simply copies of the
original reach number 1.

The two new reach numbers must also be added to the table ReachSetReachLL
along with the ReachSetID of the new stream configuration. This step provides a
formal link between the new reaches and the stream configuration. The value of
DownStrReach indicates which reach is down-stream and which is up-stream. The
reach flowing directly into a lake should have the value of DownStrReach set to its
reach number. In our example the stream may have reach 3 flowing into 2 and reach
2 into the lake (set to flow into 2). Some of the reaches can be present in more than
one stream configuration. For example, if the original stream configuration was
composed of two reaches, the reach not split would be present in both stream
configurations.

Next we should add the actual barrier. The information describing the barrier is
stored in the BarrDef table. As with the ReachSet table, adding an entry here
generates another reference number: BarrID. This number will be used as a reference
to the barrier itself. To link the barrier to the stream configuration we must also add a
record to the ReachSetBarrLL table along with the location of the barrier (the reach
immediately above the barrier).

Some of the old chemical options will apply, so we should refer to them in the
ReachSetChemOptLL table with the new ID. (All of the chemical options relevant
to the original (one reach) stream configuration should be applicable since the stream
must be able to behave with the barrier active and inactive (i.e. not yet present).) The
ChemEff table’s most important purpose is to specify which reaches are affected by
a given chemical option. A presence of a record with the appropriate reach number
signifies that a reach is affected. A chemical option can affect reaches from multiple
alternative configurations for a given stream. Only the reaches included in the
currently selected stream configuration are actually used. In our example, we should
add reaches 2 and 3 to all of the chemical options relevant to the original stream
configuration.

Adding values to the ChemEff table generates new values of the ChemEffKey field.
These should be added to the ChemEffAge with the appropriate chemical
efficiencies by age.

Next we must check the table BarrEffHyp for existing stream barrier activities
relevant to the new stream configuration. All of the stream barrier activities relevant
to the original (one reach) stream configuration should be applicable since the stream
must be able to behave with the barrier active and inactive (or not present).

In order to use these stream barrier activities, we have to replicate them for the new
value of ReachSetID along with the relevant records in tables SpawnAllocFtr and
TrapDef.

There may be new stream barrier activity which describe activity with the barrier
active, which should be added as well. See the following section for a detailed
description of BarrEffHyp and related tables.

All of relevant existing stream barrier activities should be added to the
BarrBarrEffHypLL table along with the new ReachSetID and BarrID. The value of
the field IsActive should most probably be false since the original stream
configuration did not contain the barrier. One of the BarrEffHyp entries should
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become the default stored in the ReachSet table. The most likely candidate is the one
equivalent to the default in the original stream configuration.

The next step is setting up new spawner allocation within the stream. Information
about that is stored in SpawnAllocFtr table. The table combines ReachSetID, Reach,
and BarrEffHyp values determined earlier.

If applicable, trap information should be added to the TrapDef and the TrapType
tables.

If there were any entries in the ScenarioSMRT, ScenarioTrap, ScenarioEffHyp, or
ScenarioEffHyp these may also have to be duplicated.

As the last step, if the new stream configuration should become a default for the
stream, the field ReachSetID in the table SimStream should be updated to the new
value.

Stream Barrier Activity

Stream barrier activities are used to represent the various ways in which a stream can
act. Some examples of these activities are appearance of a barrier, or a partial or a
full failure of a barrier. There can be multiple stream barrier activities defined for any
stream configuration and the behaviour can change during a simulation run.

To illustrate relationships within the database of stream barrier activities, let us
manually add a new stream barrier activity to the database. The new stream barrier
activity will describe an active barrier within the stream we added in the Stream
Configuration section above.

Before we proceed with adding a stream barrier activity, we will add a chemical
option which would be relevant to the new stream activity.

First we should add an entry into the ChemOpt table. The chemical option will treat
only the part of the stream below the barrier, ie. only reach 2. A new entry will
automatically acquire a value of ChemOpt. We use this value to add entries to the
ChemEff table with only reach 2 (reach 3 is not treated) which in turn generates a
new value of ChemEffKey which is used for entering chemical efficiencies in
ChemEffAge table.

Next we should link the new chemical option with the reach configuration by adding
an entry containing the new ChemOpt and the new ReachSetID into the
ReachSetChemOptLL table.

Now we can add a new entry to the BarrEffHyp table. The newly created ChemOpt
value will become the default option for this stream barrier activity. If there are also
values for the default annual release of sterile males, they should be added as well.

The new stream barrier activity will have a new set of spawner allocation values.
These should be added to the SpawnAllocFtr with all of the reaches present. The
reaches where there will be no spawners should receive an allocation of 0. All entries
for a particular BarrEffHyp should add up to 1, but values less than 1 can be used to
simulate lower nesting success (for more information about spawner allocation and
nesting success, see the section on adding reaches to stream configurations).

It there are any traps placed on the stream which are active year after year (eg. a
barrier trap) those should be added to the TrapDef table.
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Lamprey Basins

Database Files

With the new activity set up we can turn the new barrier on. An entry in the
ScenarioEffHyp table will turn the barrier on at the appropriate time in the
simulation. The spawner allocation will automatically change to the new one we just
set up. Additionally, should the stream be scheduled for treatment, the default will be
the new chemical option. The new entry in the ScenarioEffHyp table should only be
placed there once. It will automatically be carried forward until another change is
encountered. For example, should there be a time where we wish to simulate a
complete barrier failure, we would need to add another value to the ScenarioEffHyp
table with the old stream barrier activity. The spawner allocation and the default
chemical option will revert back to the old ones.

Lamprey basins have a function in the Great Lakes similar to the function of stream
configurations in streams. Lamprey basins partition the Great Lakes into distinct
sections. These sections can represent whole lakes or the parts of lakes to be
simulated separately. Not all lakes need to be present in all of the configurations. If
only a part of the Great Lakes basin needs to be simulated, it is more efficient to set
up a lamprey basin configuration containing only those sections needed for
simulation. As with stream configurations, there are many ways in which the Great
Lakes can be partitioned, although only one can be used in any one simulation.

There are four tables representing the lamprey basins. LampBasinDef contains a
general description of the definition itself. This description allows for the
identification of the lamprey basin and aids in the selection of which basin
configuration is most appropriate for the simulation.

The table LampBasinSubDef lists all of the sub-basins included in the configuration.
If we were to simultaneously simulate all of the Great Lakes we could define an entry
for each lake in this table.

Tables LampBasinToStream and LampStreamToBasin are used to list all of the
basins contributing spawners to streams and all of the streams contributing
transformers to basins. There can be multiple basins from which spawners migrate up
a single stream, just as a single stream can contribute transformers to multiple basins.
An example of this is the St. Mary's river which contributes and receives lamprey
from Lake Huron and Lake Michigan.

It is important to ensure that the sum of proportions of spawners for each basin and
transformers for each stream add up to one, otherwise lamprey may be miscounted.

The IMSL database was designed to protect static data and to provide a facility for
keeping multiple sets of results generated by minor modifications to a single scenario
database (e.g. budget size, crew combination, etc.). This led to the creation of three
separate component databases for each type of data:

1) Static and rarely changing parameters are stored in the options database;

2) Dynamic parameters subject to change between individual runs are
stored in the scenario database; and

3) Results of the runs are stored in the results database.
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1. Options Database

The options database (OPTIONS . MDB) contains data which rarely changes between
runs. The database contains the following tables: BarrDef, Criteria, Lake, Reach,
ReachSetBarrLL and Stream.

The tables BarrDef and ReachSetBarrLL define the barriers and contain the links
between the stream configurations and the barriers (which barriers are placed on
which streams).

Tables Lake, Reach, and Stream contain the names and the information about the
size and location of streams.

The Criteria table contains the descriptions of the four evaluation criteria.

2. Scenario Database

The scenario database (e.g. SHIST.MDB) contains dynamic data, potentially subject
to change from run to run. It contains the following tables: BarrBarrEffHypLL,
BarrEffHyp, BaseCamp, BaseCampDeplSiteLL, BudgetChem, BudgetCrew,
BudgetGen, ChemEff, ChemEffAge, ChemOpt, CummlinfRt, DeplSite,
DeplSiteStreamLL, LampBasin2Stream, LampBasinDef, LampBasinSubDef,
LampStream2Basin, ModelBasinParms, ModelGenParms,
ModelReachAgeParms, ModelReachParms, NetTrapEff, ReachSet,
ReachSetChemOptLL, ReachSetReachLLL,, ScenarioAction, ScenarioBarr,
ScenarioDescription, ScenarioEffHyp, ScenarioFish, ScenarioSMRT,
ScenarioTrap, SimStream, SpawmAllocFtr, TrapDef, TrapSummary,
TrapType, TripLL, and UserEventOpt.

Descriptions for many of these tables have been presented earlier in this Appendix.

Additionally, the tables BaseCamp, BaseCampDeplSiteLL, DeplSite, and
DeplSiteStreamLL provide information on the three base camps and the deployment
sites used from those base camps.

Tables BudgetChem, BudgetCrew, and BudgetGen hold the information about
resource availability.

Tables  LampBasin2Stream, LampBasinDef,  LampBasinSubDef, and
LampStream2Basin control the stream-to-basin and basin-to-stream allocations

Tables ScenarioAction, and TripLL allow for the building of treatment schedules,
and UserEventOpt holds the list of user-defined options.

Tables ScenarioBarr, ScenarioEffHyp, ScenarioFish, ScenarioSMRT, and
ScenarioTrap provide non-default selections for specifications.

3. Results Database

The results database (e.g. RHIST.MDB) contains the individual age structured
populations, basin populations and the stream rank list. All of this data is stored in
five tables: LampByBasin, LampByStream, LampByReach, AmmReachPop, and
RankStream.

Table LampByBasin contains the information about the size and the composition of
all of the basin populations for the current configuration (definition). The simulation
initial conditions consist of data for one year just prior to the first year of the
simulation (new data are added during the simulation).
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Table LampByStream contains the spawning run information for each of the
streams in the simulation. Entries in this table are generated from the basin
population sizes and the allocation found in the LampBasinToStream table
described earlier.

The AmmReachPop table contains the age structure for all of the reaches in the
simulation. The initial population structure for a particular year of simulation is
stored in records dated one year prior to that simulation year. Entries for each
subsequent year are generated by the model. If new reaches (and new stream
configurations) are added to the scenario database, the initial population structures
must be added to the AmmReachPop table. This is the largest of all tables in all of
the IMSL databases.

Table LampByReach contains the size of the spawner run and the summary
information on the transformer production for the reach.
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Appendix C: DB-Based Graphing

The graphing component of LCSS was designed with flexibility in mind. It allows
adding new graphs without modifications to the program itself. The graph
information is stored in 2 LCSS Scenario database tables in Microsoft Access:
Graph and GraphIVar. The data for the graph are collected in a user-defined

query.

The Graph table consists of the following fields (columns):

Graph
GraphDescription

QueryName
DVarName
DVarDescription
DispType

View

GraphType

Internal graph identifier (generated automatically)

The description of the graph is used in the list of available
graphs and the title of the graphs

The name of the query which collects the data
Dependent variable name used in the query
Dependent variable description used in the legend
0 - Graph; 1 - Table (only graph is supported)

Selection of graphs to be currently displayed (entered
through LCSS)

The type of the graph in which the data should be displayed

The GraphType column of the Graph table contains numbers that identify which of
eight available graph types will be displayed. The numbers in this field can be
modified to change the type of graph displayed by LCSS for a particular parameter.

I

I B N T S ™

Ju—y
[an

Graph Type
2-Dimensional Pie Diagram
3-Dimensional Pie Diagram
2-Dimensional Bar Graph
3-Dimensional Bar Graph
Line Diagram -

Log/Lin Graph

Area Diagram

Polar Graph

To add a new graph to the list, enter the appropriate information into a new row of
the Graph table and write the Query that will gather the data required to generate the

graph in LCSS.
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The queries used by graphs must have at least 2 output fields: an independent
variable (listed in the GraphIVar table, see below) and the dependent variable (listed
in the Graph table). The queries must be designed and stored in the LCSS Scenario
database. As a convention all of the queries should use “lcss_” as a prefix, e.g.,
lcss_SpawnRunSize. The full name of the query should be stored in the Graph
table.

lcss_SpawnBunSize : Select Query

f | SimStream
AL —
i £ J

Lake
Stream

Treat
Simulate

Keep
ReachSetlD
BudgetGroup
{InReport

: DefChemOnly

LampByStieam
*

- 1SexRatioFem
_ |SpawnLerFem -
{EggsFem
Spawniweight

Fislt | SimYear SpawnCountT otal SpawnCountT otal Simulate
Table: [LampByStream LampByStieam SimStieam
Totak | Group By Sum Where
Sort: [Ascending
Show: %] = |
Crtenia: | >=[Getl Year] And <=[GetlYear] Tiue

of:

1 o

In some cases information cannot be stored in the query or storing all of the
permutations of possible values would be too tedious (e.g. all of the streams). For
that purpose LCSS supports parameters. Only a limited number of them is currently
supported:

LSimYear First year within the simulated data obtained from the
population structure (AmmReachPop) table

USimYear Last year within the simulated data obtained from the
population structure (AmmReachPop) table

CurrLake Currently selected/simulated lake (used in ISIS)

CurrStream Currently selected/simulated stream (used in ISIS)

Run Simulation run ID (used in ISIS)

GetLYear Ask user for the lower bound of the range of years to
display

GetUYear Ask user for the upper bound of the range of years to
display

GetAge Ask user for age (single value)

[Simulation Year] Asks user for a specific simulation year
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[Lake First Letter]

Asks user for the first letter of a lake to be displayed
(0, E, S, M, or H)

[Stream #]

Asks user for a stream number

In order to use any of these parameters, the exact spelling and spacing must be used
(including the square brackets “[ ]7).

The GraphIVar table stores information about the independent variables for the
graph. While the table structure is designed to support multiple independent
variables, graphing module will support only one. It has the following fields

(columns):
Graph Internal graph identifier generated automatically
Ivar The “count” of the current variable
IvarName Independent variable name used in the query
IVarDescription Independent variable description
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Appendix D: Quick Tips for the Use of LCSS and ISIS

LCSS Quick Tips

Biological Parameters — Simulating No Suitable Habitat (page 4-39)

[lg: You can simulate no suitable spawning habitat (remember that you cannot set Habitat Area
to 0, see page 4-26) by setting Egg Survival Rate here on the Reach parameters screen to 0.

Biological Parameters — Simulating Reproductive Success (page 4-39)

B@ You can simulate reproductive success by modifying egg survival rate.

Budget and Resources — Barrier Extraneous Expenses (page 4-8)

@ Barrier extrancous expenses can be specified by selecting the Barriers command button
which activates the Stream Barriers screen (see page 4-28). From there, select extraneous
expenses (Ex. Expenses) to access the Extraneous Stream Barrier Costs screen (see page 4-

29).

Budget and Resources - Budget Groups (page 4-7)

ng In future versions of the program, different organizational units or institutional groups will
be able to set new budgets, as specified by the Budget Group category (top of screen). At
present, LCSS uses a single budget group to represent the Great Lakes Fishery Commission

Program for all lakes.

Budget and Resources - Chemical Stocks (page 4-12)

[@: You can set both the Current Stock and the Stock Cost/Unit values and keep them at those
values. To do so, you need to turn off the automatic stock update command in the General
Options screen. Otherwise, the system will overwrite the entered value.

Budget and Resources — Total Program Costs (page 4-13)

[@ In order for the system to calculate the total SMRT costs, you must conduct a simulation run
before calculating the budget.

Lamprey Allocation — Basins screen (page 4-41)

l@a The selected basin configuration will affect the allocation of lamprey when running the

model. For example, if you choose a lamprey basin configuration that contains only Lake

Superior, you should not simulate streams from other lakes. The current lamprey basin
configuration is always displayed on the status bar at the bottom of the screen.
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Ranking Criteria — Fish-related Criteria (page 4-14)

[@: The fish model has not yet been linked to the lamprey model, so the two fish-related ranking
criteria are not supported by the Treatment Schedule.

Stream Barrier Activity - Allocating Spawners to Reaches (page 4-37)

n@: This screen is used to allocate spawners from streams to reaches. If you want to allocate
spawners from basins to streams, you must use the Lamprey Allocation option under the
Edit Menu.

Stream Configuration — Habitat Area (page 4-27)

ng: It is important to ensure that the value set for Habitat Area is greater than 0. Otherwise, the
system will not perform its simulation properly. To represent a situation in which there is
no suitable habitat for lamprey, set Habitat Area (on the Physical Reach Parameters screen)
to 1 and Egg Survival (on the Reach tab of the Biological Parameters set of screens, see
page 4-39) to 0.

Stream Population — New Population Records screen (page 4-57)

[Ig When a new reach is created using Edit[Stream Setup, the system adds it to the list of
reaches in the Stream Population screen. The reverse, however, is not true. The Del Year
function in the Stream Population screen deletes only the lamprey population information
associated with the selected reach and not the physical reach itself. To delete a reach
altogether, you must use the Physical Reach Parameters screen in Stream Setup.

Stream Population — Stream Ammocete Number by Size screen (page 4-56)

Values entered in this screen are for display purposes only and will not affect the
simulation.

Stream Setup — Selecting Streams for Treatment or Simulation (page 4-24)

0%3 The simulate flag and the basin-to-stream allocation are not linked. If you do not include a
stream on the simulation list, you must delete the allocation to that stream (see the Lamprey
Allocation option on the Edit Menu).

Stream Setup — Selecting Streams for Treatment or Simulation (page 4-24)

[@ It is currently impossible to define new streams through the LCSS interface. To do so, you
must use the native MS Access interface, and add the new record to 2 tables: Stream and
SimStream (see Appendix B). Once the records are there, the Stream Setup family of
screens in LCSS can be used to define the stream.
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Trip Management — Ordering Events in a Trip (page 4-18)

IS

To make it easier to change the order of events in a trip, put "dummy" user events as the first
and the last event in a trip. When you have changed the order, remove the "dummy" events.
LCSS will automatically move the start date of the first event up and add the appropriate
travel time at the beginning and the end of the trip.

ISIS Quick Tips

Stream Configuration — Habitat Area (page 5-9)

Iy

It is important to ensure that the value set for Habitat Area is greater than 0, otherwise the
system will not perform its simulations properly. To represent a situation in which there is
no suitable habitat for lamprey (i.e., Habitat Area is 0), set Habitat Area to 1 and Egg
Survival Rate (using the BioParms tab, below) to 0.

Stream Parameters|Activity tab — Spawner Allocation to Reaches screen (page 5-17)

=

This screen allocates spawners from streams to reaches. To allocate spawners from basins to
streams, go to the Lamprey Allocation option in LCSS (page 4-40).

Stream Parameters|Spawners tab (page 5-22)

=

CAUTION: To avoid the possibility of conflicts, currently loaded stream-basin-stream
allocation data are deleted prior to loading a new set of values. This may cause some
streams to behave differently following the loading of an unrelated stream (due to different
survival rates of parasitic phase lamprey and different proportions of returning spawners).

Stream Parameters|Traps tab (page 5-18)

=

A default trap placement is specific to the stream barrier activity being simulated on the
stream to which the trap is added. For example, if the stream barrier activity for the
Amnicon River is set to “no barrier or barrier not active”, the trap is present whenever this
stream barrier activity is simulated.

Stream Parameters|Traps tab (page 5-18)

=

Whereas default traps are linked to stream barrier activity, non-default traps are defined for
a given year and are not dependent upon the stream barrier activity being simulated.
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